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Disclaimers

Lattice makes no warranty, representation, or guarantee regarding the accuracy of information contained in this document or the suitability of its
products for any particular purpose. All information herein is provided AS IS, with all faults, and all associated risk is the responsibility entirely of the
Buyer. The information provided herein is for informational purposes only and may contain technical inaccuracies or omissions, and may be otherwise
rendered inaccurate for many reasons, and Lattice assumes no obligation to update or otherwise correct or revise this information. Products sold by
Lattice have been subject to limited testing and it is the Buyer's responsibility to independently determine the suitability of any products and to test
and verify the same. LATTICE PRODUCTS AND SERVICES ARE NOT DESIGNED, MANUFACTURED, OR TESTED FOR USE IN LIFE OR SAFETY CRITICAL
SYSTEMS, HAZARDOUS ENVIRONMENTS, OR ANY OTHER ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, INCLUDING ANY APPLICATION IN
WHICH THE FAILURE OF THE PRODUCT OR SERVICE COULD LEAD TO DEATH, PERSONAL INJURY, SEVERE PROPERTY DAMAGE OR ENVIRONMENTAL
HARM (COLLECTIVELY, "HIGH-RISK USES"). FURTHER, BUYER MUST TAKE PRUDENT STEPS TO PROTECT AGAINST PRODUCT AND SERVICE FAILURES,
INCLUDING PROVIDING APPROPRIATE REDUNDANCIES, FAIL-SAFE FEATURES, AND/OR SHUT-DOWN MECHANISMS. LATTICE EXPRESSLY DISCLAIMS
ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS OF THE PRODUCTS OR SERVICES FOR HIGH-RISK USES. The information provided in this document
is proprietary to Lattice Semiconductor, and Lattice reserves the right to make any changes to the information in this document or to any products at
any time without notice.

Inclusive Language

This document was created consistent with Lattice Semiconductor’s inclusive language policy. In some cases, the language in underlying tools and
other items may not yet have been updated. Please refer to Lattice’s inclusive language FAQ 6878 for a cross reference of terms. Note in some cases
such as register names and state names it has been necessary to continue to utilize older terminology for compatibility.
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Abbreviations in This Document

A list of abbreviations used in this document.

Glossary Definition

BSP Board Support Package, the layer of software containing hardware-specific drivers and libraries to function in a
particular hardware environment.

CPU Central Processing Unit

csv Comma Separated Values file

DGE Design Generator Engine

DRC Design Rule Check

DUT Design Under Test

ESI Previous name of Propel

FPGA Field Programmable Gate Array

GUI Graphic User Interface

HDL Hardware Description Language

HSM Hardware Security Module

IDE Integrated Development Environment

IP-XACT An XML format that defines and describes electronic components and their designs.

IPX Internet Packet Exchange

LHS Left Hand Side

LSB Least Significant Bit

MSB Most Significant Bit

(6N Operating System

Perspective

A group of views and editors in the Workbench window.

PGE

Package Generate Engine

A tool can program Lattice FPGA SRAM and external SPI Flash through various interfaces, such as JTAG, SPI, and

Programmer c.

RHS Right Hand Side.

RISC-V A free and open instruction set architecture (ISA) enabling a new era of processor innovation through open
standard collaboration.

SBX The files that store the spatial index of the features

SDK Embedded System Design and Develop Kit. A set of software development tools that allows the creation of
applications for software package on the Lattice embedded platform.

SGE Software Generator Engine

SoC System on Chip. An integrated circuit that integrates all components of a computer or other electronic systems.

SRAM Static Random Access Memory

TCL Tool Command Language

UFM User Flash Memory

VIP Verification IP

Workspace The fiirectory whgre stores your work, which is used as the default content area for your projects as well as for
holding any required metadata.

Workbench The desktop development environment in Eclipse IDE platform.
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1. Introduction

Lattice Propel™ 2024.1 Builder is a graphical tool used to assemble complex System-on-Chip (SoC) modules which can
be used in the supported Lattice FPGA devices. These modules and/or IP can be assembled and connected easily by
simply dragging and dropping the modules and/or IP into the Schematic Window.

1.1. Purpose

Embedded system solutions play an important role in FPGA system design allowing you to develop the software for a
processor in an FPGA device. It provides flexibility for you to control various peripherals from a system bus.

To develop an embedded system on an FPGA, you need to design the System on Chip (SoC) with an embedded
processor. Lattice Propel Builder helps you develop your system with a RISC-V processor, peripheral IP, and a set of
tools by a simple drag-and-drop.

The purpose of this document is to introduce Lattice Propel 2024.1 Builder tool and design flow to help you quickly get
started to build a small demo system. You can also find the recommended flows of using Lattice Propel Builder in this
document.

1.2. Audience

The intended audience for this document includes embedded system designers and embedded software developers
using Lattice MachX03D, MachXO3L, MachXO3LF, MachX02, LIFCL, LFD2NX, LFMNX, LFCPNX, LFMXO5, and LAV-AT
devices. The technical guidelines assume readers have expertise in the embedded system area and FPGA technologies.
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2. Lattice Propel Builder Design

The Propel Builder design includes creating a SoC project design, and a verification design. The workflow is described
below, and the details are explained in the following sections.

Operation in Propel Builder

1. Launch Lattice Propel Builder x‘

]

2. Create Empty Project or
Open an Existing Project

Local Foundation IP
IP from Server

3. Instantiate IP or
Modify Existing IP

]

4. Connect Modules to
Adjust Address Space

I

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
l
} 5. Design Rule Check @
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
I
I
I
I
I
I
I
I
|

Create C/C++

6. Launch Profect 4 outout ol

Validate Design Propel SDK roject to utput .mem File
Compile Project

I

‘ 7. Initialize Memory }‘

i 9. Launch R he Board 13. On Chip Deby,
‘ 8. Save Design H }—‘—V Lattice Radiant Export .bit/.jed Files Program to FPGA esetthe Board | | . P e
to Boot Image in Propel SDK

or Diamond *

l

10. Switch to

Verification Project [

i

11. Generate Simulation
Environment

2

12. Launch Simulation Tool
to Do Simulation B

Figure 2.1. Propel Builder Workflow

2.1. Builder Environment
After Propel 2024.1 is installed, you can launch the stand-alone Propel Builder by double-clicking the Run Propel

Builder icon ( u"l") from the toolbar.
You can also invoke the Propel Builder from the command line:

e Run the following command in Windows:
<propel_installation_directory>\builder\rtf\bin\nt64\propelbld.exe -gui

e  Run the following command on Linux:
< propel_installation_directory>/builder/rtf/bin/1in64/propelbldwrap -gui

Refer to the Lattice Propel 2024.1 Installation for Windows User Guide (FPGA-AN-02088) and Lattice Propel 2024.1
Installation for Linux User Guide (FPGA-AN-02089) for details on the installation.

Note:

When you create a Propel SoC project, a linked verification project is always generated as well. Refer to the Switching
from SoC Design Project to Verification Project section for more information on verification project.
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After the Propel Builder is launched, a single workbench window is displayed. The workbench contains Menu, Toolbar,
Design View, IP catalog, Schematic view, address mapping, Start Page, and TCL console. Figure 2.2 shows the
workbench after opening a project.

1. Menu bar
2. Toolbar
3. IP Catalog and Design View
4. Schematic View, Address Mapping, and Start Page
5. TCL Console
% Propel Builder [C/lsccy /l / /h .sbw] Device: LFOPNX-100-9LFG672C Board: CertusPro-NX Evaluation - o X
Fle Edt Wiew Desgn Tools Window Hep l
CEBHOCoAMEsNoBeno QRAQ ]2
P Catslog o Schematic Address % StartPage
cs ]
Ponlocal TP on Server L= &
B Module/P on Local
» [T Architecture_Modules
Arithmetic_Modules
lemory. Modules.
cessors Controllers_and_Peripherals Syt st
v [ Verfication [P =
A st
= [ Processors_Controllers_and_Peripherals ,
@ spo 160 6
@ mscvme 207 1
@ uarr (LT R, “_;b" =
s
o ‘
L
i
[ ==
v 1 1, sy
Job f= ws -
O ol 2
,>,
et 3 4
Tel Console - [u]
% sbp_design open -neme HelloWorld -path (C:/lscc/workspace/EelloWorld/HelloWorld/HelloWorld.sbx}

Figure 2.2. Propel Builder Workbench Window

2.2. Project Design Flow

2.2.1. Creating SoC Project

-

B
Choose File > & New Design from the Lattice Propel Builder Menu bar. The Create System Design wizard

(Figure 2.3) opens.

© 2024 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
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4, Create System Design >

Design Information
Enter a name for your design and specify a directory where the design files will be stored.

Project:

Type: SoC Project b

Mame: Example

Location: | Cifllsccfwarkspace * | | Browse...

Create Project at C:/lscc/waorkspace Example

Mext > Cancel

Figure 2.3. Create System Design — Design Information Wizard

The default Project Type is displayed in the Type field. Select SoC Project from the drop-down menu.
Enter a project name in the Name field, such as ‘Example’.

(Optional) The default location is shown in the Location field. Use the Browse... option to change the project
workspace location.

Note:

Long path is not supported well in Windows OS. If there is a file existed under the path but get a prompt of No
such file, try moving this file to a directory with a shorter path.

Click Next. In the Configure Propel Project wizard, you can specify a device or a board for a SoC project.
To specify a device for your new SoC project, use the drop-down menu to select desired device information (Family,
Device, Package, Speed).

Select Template SoC Project (RISC-V *** Project) or Empty Project in the Templates field (Figure 2.4).

Templates are customized with commonly used programs as well as pre-defined family, device, package, speed, and
operating condition. There are several templates here, which are programmed to run demo. You can make changes
based on these templates.
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4y, Create System Design

Configure Propel Project
Spedify a device or board for project.

RISC-V MC IP based SOC Project.
Components induded:

a) Processor - RISC-V MC w PIC,TIMER.
b) GPIO

Online Data Sheet for Device

Language: Template Categories:
Verilog * | | All Templates
Family: Board | Processor:
LFD2MY (Certus-Mx) * | RISC-V MC
Device: Templates:
LFDZNX-40 - | Empty Project
iRISC-V MC SoC Project
Package:
CABGAZ25G &7
Speed:
&_High-Performance_1.0v -
Operation Condition:
Commercial <
Template Info:

Device Information:
Part Number:

Logic Cells:

LUTs:

Registers:

EEBR Blocks:

LR.AM:

DSP (18x18 Multiplier):
ADC Blocks:

PLLs:

DLLs:

PCSs:

ALUs:

DPHYs:

PIO Cells:

FIO Pins:

LFD2NX-40-8BG256C
39000
32256
32256

Template Manager

< Back

Mext = Cancel

Figure 2.4. Specify a Device for Template SoC Project

e Or, to specify a board for a new Template SoC project, check the Board box (Figure 2.5).
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4. Create System Design P4

Configure Propel Project
Spedify a device or board for project.

Language: Template Categories: Device Information:
Verilog v | | All Templates - | Fart MNumber: LFD 2MX-40-8BG256C
Logic Cells: 39000
Board Select: Board| Processor: LUTs: 32755
i Certus-MX Versa Evaluation ¢ | RISCY MC - | | Registers: 32256
CertusPro-MNX Evaluation Temclates: EER Blocks: 34
CrossLink-MNX Evaluation e : LRAM: o3
Lattice Sentry Demo Board for Mach-NX (256) :;Et{{ Tn:l?:Je;tc e DSP (18x18 Multiplier): 56
i " - oC Proje
Latt?ce Sentry Demo Board for Mach-MNx (484) il ADC Elocks: 1
Lattice-Avant Evaluation i z
MachX02 Breakout '
MachX03D Breakout DlLs: 2
MachX03D PFR Demo e L
MachX05-MNX Development Board REV A ALUs: 1
DPHYs: 0
PIO Cells: 185
PIO Fins: 185
Template Info:
RISC-Y MC IP based S0OC Praoject. -
Components induded:
a) Processor - RISC-V MC w/ PIC/TIMER
b_} GPIO ) -
Online Data Sheet for Device Template Manager
< Back Mext = Cancel

Figure 2.5. Specify a Board for Template SoC Project (1)

Notes:
e  You can see both empty project and some predefined templates listed in Templates field.
e Select a desired template from the Templates area, such as RISC-V MC SoC Project.

e  Templates usually have been validated on that board and some of them may have certain constraints. Check
Lattice Propel 2024.1 Release Notes (FPGA-AN-02090) for more information on constraints.

6. The Configure Propel Project wizard is shown in Figure 2.6. From the Board Select area, select the desired board.

© 2024 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
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4, Create Systern Design

Configure Propel Project
Spedify a device or board for project.

Language: Template Categories:
Verilog ¥ | | all Templates
All Templates
Board Select: [ Board “User Templates
Certus-MNX Versa Evaluation RISC-V MC

CertusPro-MNX Evaluation
CrossLink-NX Evaluation
Lattice Sentry Demo Board for Mach-MX (256) Empty Project

Lattice Sentry Demo Board for Mach-MNX (424) RISC-V MC 5oC Project
Lattice-Avant Evaluation

MachX02 Breakout

MachX03D Breakout

MachX03D PFR Demo

MachX05-MX Development Board REV A

Templates:

Template Info:
RISC-V MC IP based SOC Project.

Components incuded:
a) Processor - RISC-V MC w/ PIC/TIMER
b) GPIO

(=]
u
=
i

Device Information:

Part Mumber: LFD2MX-40-8BG256C
Logic Cells: 33000
LUTs: 32256
Registers: 32256
EBR. Blocks: 84
LRAM: 2
DSP (18x18 Multiplier): 56
ADC Blocks: 1
PLLs: 3
DLLs: 2
PCSs: 1
AlLUs: 1
DPHYs: 0
PIO Cells: 185
PIO Pins: 185
Template Manager
< Back Mext = Cancel

Figure 2.6. Specify a Board for Template SoC Project (2)

Notes:

e You can choose VHDL/Verilog in Language filed. The top wrapper is to be generated in your selected language.

All other IP and modules are generated in their default language.

e Template Manager is for you to customize your own template that can be imported later. Refer to the Define

Custom Template section for more information.

e  Custom templates (User Templates) can also be selected from this page, from the drop-down menu of

Template Categories.

7. (Optional) About the Processor section (Figure 2.7):

e If you create an empty project, you do not need to make any selection.

e If you want a template with a specific processor type, you need select the correct processor.

e Different processors are with different templates. For example, RISC-V RX processor is with different

templates from those for RISC-V MC processor.
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4. Create System Design X

Configure Propel Project
Spedify a device or board for project.

Language: Template Categories: Device Information:
Verilog v | | Al Templates - | PETE Mumber: LFCPMNX-100-9LFG&T2C
Logic Cells: 96000
Board Select: Board Processor: LUTs: 79872
Certus-NX Versa Evaluation RISC-V MC w ||| Registers: 79872
CertusPro-MNX Evaluation HTSES ME i} EBR. Blocks: 208
CrossLink-MNX Evaluation RISC-V RX LRAM: 7
Lattice Sentry Demo Board for Mach-NX (256) RISC-V SM . DSP (18x18 Multiplier): 156
Lattice Sentry Demo Board for Mach-MNX (434) RISC-V MC Dual Processor Project ADC Blocks: 1
Lattice-Avant Evaluation RISC-V MC SoC Project - a
MachX02 Breakout '
MachX03D Breakout DlLs: 2
MachX03D PFR Demo = 2
MachX05-NX Development Board REV 4 ALUs: 1
DPHYs: 0
PIO Cells: 299
PIO Pins: 299
Template Info:
RISC-V MC IP based SOC Project to demonstrate dual processor features. -

Components induded:
a) Processor - Dual RISC-V MC
b_) UART an_d GPIO -

QOnline Data Sheet for Device Template Manager

< Back Mext = Canicel

Figure 2.7. Specify a Board for Template SoC Project (3)

8. Click Next. The Project Information wizard opens, check and confirm the project information (Figure 2.8).

&, Create System Design *

Project Information
Generate new project with the following specifications.

Project:

Project Mame: Example

Project Location: G/lscc/workspace/Example
Language: Verilog

Device: LFCPNX-100-8LFGE72C

Speed: 8 High-Performance_1.0V

Template Name: RISC-V MC SoC Project
Board Name: CertusPro-NX Evaluation
Processor Name; RISC-V MC

< Back Finish Cancel

Figure 2.8. Project Information Wizard

9. Click Finish. Propel Builder GUI opens (Figure 2.9).
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% Propel Buider [C-/lcc/workspace/Example/Example/Example.ci] Device: LECPADX-100-9LFGET2C Bosnd: CertusPro-NX Evakustion - @
file Edt Yew [Qesign Jook Window Help
P - | BMEE x5 @2 QQaa
[Design View o Schemate acress 4 Searteage

1B LFCPHOX-100-UFGETC

——
= L
| =
o IO t — bt et
[ = e
| ey

VLN ticecsysteminader Exampie: 10
Fle:  C:lscsjmorkepace Exampie Examle Exampie.sbx

Figure 2.9. Propel Builder GUI showing Template SoC Project

10. (Optional) If you want to see all templates while creating a SoC project, you can use New SoC Design.

. Propel Builder - [m]
File Edit View Design Tools Window Help
d- B & B EE KD aQaaea =
IF ew Design (m} 4, Start Page
Y
1P on Local IP on Server T
[ Module/IP on Local a We'come Back
~ Module
» Architecture_Medules R R
b (7 Arithmetic_ Modules [T A=
v Embedded_IP my_soc
» Memory_Modules
+ {1 Processors_Controllers_and_Peripherals
v [ Verification IP
5 AHBLite Master BFM Lite Version 1.00
7 Clock and Reset Generator 100
5 UART Model 1.00
- P
~ [ latticesemi.com
» 1 Processors Controllers and Perioherals -
:/ L3
f = nus-E }nus —>>—
tl equation split concat invert
Tel Console m]
% sbp_design close
INFO <2359134> - Finished: sbp_design close
Finished: "sbp_design close"
%

Figure 2.10. New SoC Project in Another Way

You can get detailed information on Template in this flow (Figure 2.11).
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% Propel Create Project

Select Template

Select a template by name and version from the list of templates.

User Only

Name
Emnpty Project
Lattice Sentry RoT Project
Lattice Sentry RoT Project (236)
Lattice Sentry RoT Project (484)
Lattice_MachX050_RoT_Project_1
RISC-V MC Dual Processor Project
RISC-V MC SeC Project
RISC-V RX 50C Project
RISC-V RX SoC Project for Avant GT0/X70
RISC-V 5M SoC Project

5HA-3 CFU Project

Processor

Version

RISC-V MC,RISC-V SM,RISC-V RX None

RISC-W MC

RISC-V MC

RISC-W MC

RISC-W MC

RISC-V MC

RISC-W MC

RISC-V RX

RISC-V RX

RISC-V 5M

RISC-V RX

Naone

None

Naone

1.0

MNone

None

Mone

None

None

Naone

Template Manager

Template Info:
Empty project for user to "build from scratch™

Supported Boards:
Certus-MX Versa Evaluation,
CertusPro-M¥ Evaluation,
CrossLink-MNX Evaluation,
ECP5-5G Versa,
Lattice Sentry Demo Board for Mach-MX (256),
Lattice Sentry Demo Board for Mach-MX {(484),
Lattice-Avant Evaluation,
MachXO2 Breakout,
MachX030 Breakout,
MachXO3D PFR. Demo,
MachXO5-MX Development Board REV A

< Back MNext = Cancel

Figure 2.11. New SoC Project — Select Template

Click User Only to see user custom template (Figure 2.12). Refer to the to Define Custom Template section for how to

use Template Manager.
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. Propel Create Project x
Select Template
Select a template by name and version from the list of templates.
User Only Template Info:
Name Processor Version
Lattice_MachXO50_RoT Project_ 1 RISC-VMC 1.0 Supported Boards:
MachX0Q5-MX Development Board REV A
Template Manager
< Back Mext = Cancel

Figure 2.12. New SoC Project — Select Custom Template

You can choose Device/Board in this flow as well (Figure 2.13).
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&, Propel Create Project *
Select Device
Select a device or board for current template.
Board ~* Device Information:
Name Version Part Number: LFDIZNX-40-8BG256C
Certus-NX Versa Evaluation A Logic Cels: 35000
LUTs: 32256
CertusPro-MNX Evaluation A Registers: 32256
CrossLink-NX Evaluati A EER Blocks: 84
rossLink- valuation T 3
ECP5-5G Versa A DSP (18x18 Multiplier): 56
ADC Blocks: 1
Lattice Sentry Demo Board for Mach-NX (238) A PLLS: 3
Lattice Sentry Demo Board for Mach-NX (424) A Dl 2
PCSs: 1
Lattice-Avant Evaluation A AlUs: 1
DPHYs: i}
MachX02 Breakout A :
PIO Cells: 185
MachX03D Breakout A PIO Pins: 185
MachX03D PFR Demo A
Mach¥035-MNX Development Board REV A A
Online Data Sheet for Device
< Back Mext = Cancel

Figure 2.13. New SoC Project — Select Device

2.2.2. Opening an Existing SoC Project

[
1. Toopen an existing SoC project, choose File > “— Open Design from Propel Builder GUI menu or click Open
| S |
Design icon “— from Propel Builder Toolbar (Figure 2.14).

Fe G Ve Degn ok Wiew Help
3 NewDusgn .
Open Design L U

RecentDesigns  +

Welcome Back

Recent Project List

Embedded 1P

Mamory Modules
trolers_and Pergherals

= tastes BFM Lite Vession 100

% Clock and Reset Generater 100
5 UART Model 100

R

v Pubiclp

e

Figure 2.14. Open Design
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2. Browse to find the default project workspace folder or your own project workspace folder. Choose the sbx file,
such as HelloWorld.sbx (Figure 2.15).

4. Open shx =
&« v » ThisPC » Windows (C:) » lscc » workspace » HelloWorld » HelloWorld v [J] O Search HelloWorld

Organize v MNew folder == « [N o

Name ~ Date modified Type Size
3t Quick access
application 4/14/2022 10:03 AM File folder
@, OneDrive lib /2022 10:03 AM File folder

|:] HelloWorld.shx 4/14/2022 10:03 AM SBX File 1.412KB

& This PC
3D Objects
[ Desktop
ti] Documents
‘ Downloads
J) Music
= Pictures
m Videos
m Windows (C:)

s Mew Volume (D)

¥ Network

File name: | HelloWorld.shx v| Shx Files (*.sbx) w

Figure 2.15. Open Existing Project

3. Click Open. The Builder GUI shows the SoC design.

You can also use File > Recent Designs from Propel Builder Menu (Figure 2.16) to quickly open a recently closed
project.

A Propel Builder
File Edit View Design Tools Window Help

New Design -
o N 9 =
— b
= Open Design L"—| Q e N @ a Q Q
Recent Designs~ » a 4. Start Page
Server T
idules
3 Krithmetic_Modules
[3 Memory_Modules
3 Processors_Controllers_and_Peripherals
3 Verification [P
> P
- Connectivity
@ pc-scmLTPI 120
@ P 121 57
@ SGMIland Gb Ethemet PCS 130 [T
© TSEMAC 120 &
. f — Bus-E }BUS —
rtl equation split concat invert

Figure 2.16. Open Recent Project
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2.2.3. Generating and Instantiating IP/Module

After starting a Propel Builder project, you can add modules by dragging them from the IP Catalog view to the
Schematic view. The IP Catalog view comes with a large variety of modules for common use and some glue logic
modules, which can be found from the IP on Local tab. You can also click the IP on Server tab to find and download
more modules for specialized use (Figure 2.17).

(Optional) From the Propel Builder GUI IP Catalog area (Figure 2.17), choose the IP on Server tab. Select a desired IP. IP
version is displayed along with the IP name. For downloadable IP, a © Install button is shown. @ indicates this IP is
not compatible with the current version of Propel or the current device. You can hover the mouse over the @ tosee
the warning message details about why the IP is not supported (Figure 2.18). If the IP is already installed, “Installed” is
shown (Figure 2.17).

4. Propel Builder
File  Edit

= M =
IP Catalog O
BRCX

IF on Local

View Design Jools Window Help

IF on Server T

@ Lattice Sentry PLD Interface

O Lattice Sentry PLD Interface

O Lattice Sentry PLD Interface for Mach-MNX
O Lattice Sentry Embedded Security Block Muzx
O Lattice Sentry Embedded Security Block Mux
O Tirner-Counter

O Tirmer-Counter

O Tirner-Counter

@ 6riO

@ ario

@ GrIo

@ Grio

@ GPIO

{7 |Lattice Sentry I2C Filter

110 @ -
120 @
130 @
100 @
110 @
100 @
111 @
121 @
120 @
130 @
140 @
150 §0)

1.6.1 Installed

1.0.0 Installed

@ 12C Master 111 O
@) 12C Master 120 @
@) 12C Master 130 @
@) 12C Master 140 @
@) 12C Master 150 @
@ Lattice Sentry 12C Menitor 100 O
@ 12C Slave 130 @
@ 12C slave 140 @
@) 13C Master 230 @
@ 13C Slave 221 |nstalled

Figure 2.17. IP on Server
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IP on Local IP on Server
) CMN Coprocessor Unit 120 ©
() Lattice Sentry PLD Interface 100
{7 Lattice Sentry PLD Interface 1100
() Lattice Sentry PLD Interface 120 ©
0 Lattice Sentry PLD Interface for Mach-MX 1.3.0 C}

(7 Lattice Sentry Embedded Security Block Mux 1.0.0 '{:}
@) Lattice Sentry Embedded Security Block Musx 110 O

) Timer-Counter 100
() Timer-Counter 110
@ Timer-Counter 122 O

@ Grio 120 @
(2] (5N 1306
oo 140 O

IP: gpio Version: 1.3.0
Vendor: latticesemi.com 1.3.0 O
ga 1681 Installed
i This IP can only be used in Propel Software 1.0.0 Installed
| version 1.7 and lower. Cfffk{::} 11.0 O
to install this |P.

¢ IS VT SLET 1-1-1 C}

@ 12C Master 120 @
@ 12C Master 130 @

@ 12C Master 140 @

@ 12C Master 150 @

(7 Lattice Sentry 12C Monitor 1.0.0 1:}

@ 12C Slave 130 ©
@ 12C Slave 140 @

@ 13C_Controller 3.00 @
@ 13C Master 2300
@ 13C Slave 221 Installed
@ 13C Target 300 @
{7 Internal Flash Controller for MachX05-NX 1.0.2 l{:}

Figure 2.18. Hover Mouse over the Icon

You can use the filter and search function in IP catalog to find the IP you desire (Figure 2.19).
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4. Propel Builder
Eile Edit View Design Tocols Window Help

JEHR VYO N
IP Catalog
IP on Local IP on Server

EQ&

k -

AHB-Lite AFPB AT AXI4-Stream
Search:

Show latest IP version only

Show only IP supported by target device

B 1P server
- [P
A |E'| Audio_Video_and_Image_Processing

@ Automatic White Balance
@ Automatic White Balance
@' Byte to Pixel Converter
@' Color Correction Matrix
@' Color Correction Matrix

@ Debayer
@ Debayer
@' Pixel to Byte Conwverter
~ [ Connectivity
@ DC-5CMLTPI
© pc-scm el
@ DC-5CMLTPI
(@ DC-5CMLTPI
@ pciEX
@ SGMIl and Gb Ethernet PCS
@ SGMIl and Gb Ethernet PCS

1.00 &
110 &
160 &
100 &
110 &
1.00 &
110 &
150 &

1.0 &
121
130 3
141 (O
1.2.1

[ARNS
120 &

Installed

T

Figure 2.19. IP Filter and Search

1. Being installed successfully, the new IP is shown in the IP on Local tab (Figure 2.20).

Note: Only IP that are compatible with the current device can appear under IP on Local.
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@ criO
@ crio

@ 13C Slave

¢ 5FE Interface
@ SPI Master
@ SPI Master
@ sPISlave
@ SPISlave

© © uvarT

¢ Watchdog Timer

- ||f'| Processors_Controllers_and_Peripherals

160 T
161 1
221 1
101
131 15
140 T
140 T
150 1
130 T
140 T

4. Propel Builder
Eile Edit View Design Toocls Window Help
o= Y
a L E ¢ N .% E @ 2
IP Catalog O
=
mREs - 4
IP on Local IF on Server T-
Module/IP on Local
* Module
r EArchitecture_Modules
k EArithmetic_Modules
r |'f'| Mernory_Modules
k ||f'| Processors_Controllers_and_Peripherals
¥ [ Verification IP
- |p
r Connectivity

i;

TTT

J=

rtl

equaticn split

concat

st Jaus >

invert

Figure 2.20. IP Catalog

2. Fromthe IP on Local tab, select a desired IP, such as GPIO. Double-click the IP module, or drag and drop the IP
module to the Schematic view. A Module/IP Block wizard pops up (Figure 2.21).
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4. Maodule/IP Block Wizard x

Generate Component from IP gpio Version 1.6.0
This wizard will quide you through the configuration, generation and instantiation of this Module/IP. Enter the following
information to get started.

Component name:  gpio0

Create in:

Mext = Cancel

Figure 2.21. Module/IP Block Wizard — Generate Component from Module gpio Version 1.6.0

3. Enter a component name in the Component name area, such as gpio0. Click Next. Module/IP Block Wizard shows
the Configure Component from IP gpio Version 1.6.0 page (Figure 2.22).

% Module/IP Block Wizard s

Configure Compeonent from Meodule gpio Version 1.6.0
Set the following parameters to configure this component.

Diagram gpioc0 Configure gpio0:
“| Property Value
~ General
MNumber of 1/0 Lines [1-32] 1

Remove Tri-State Buffer
Initial Output Value (hex) [0 - FFFFFFFF] | 0

gp|00 0 Direction (hex) [0 - FFFFFFFF] :

APB_S0

Interface APB

INT

gpio_io[0:0]

gpio

1 3 Mo DRC issues are found.

< Back Generate Cancel

Figure 2.22. Module/IP Block Wizard — Configure Component from IP Gpio Version 1.6.0
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4. (Optional) Reconfigure IP. Click the Value field. Enter a desired value for a property. Or check the checkbox to
enable a property. You can also select a desired value from the dropdown menu for a property in the Value area.
The property in gray is not configurable. By changing the value, the property is thus configured.

Note: You need to generate the overall project for the IP to be generated or for any changes to take effect. Refer to
Generating the Propel Design section for more info on how to do this.

5. Click Generate. Module/IP Block wizard shows the Check Generated Result page (Figure 2.23).

4. Module/IP Block Wizard x

Check Generated Result
Check the generated component results in the panel below. Unchedk option 'Insert to project’ if you
do not want to add this component to your design.

Component 'gpiol’ is successfully generated.
Module: gpio  Version: 1.6.0

Vendor: latticesemi.com

Language: Verilog

Generated files:

IP-XACT _compaonent: component, xml
IP-XACT _design: design.xml
black_box_verilog: rilfgpiod_bb.v

cfg: gpiod.cfg

IF package file: gpiod.ipx
template_verilog: misc/gpio0_tmpl.v
dependency_file: testbench/dut_inst.v
dependency_file: testbench/dut_params. v
template_vhdl: misc/gpiod_tmpl.vhd
top_level_verilog: rilfgpiod.v

ﬂ Insert to project

< Back Finish

Figure 2.23. Module/IP Block Wizard — Check Generated Result

6. Select Insert to project (Figure 2.23) at the bottom of the Check Generate Result wizard, so that a Define Instance
dialog box pops up as shown in next step. Or, this dialog box does not appear.

7. After selecting Insert to project, click Finish (Figure 2.23). The Define Instance dialog box opens (Figure 2.24).

4. Define Instance 7 bt

Instance Mame: gpiod_inst
Instance Reference: gpiol:1.6.0

K. Cancel

Figure 2.24. Design Instance Dialog Box

© 2024 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice

FPGA-UG-02212-1.0 27


http://www.latticesemi.com/legal

Lattice Propel 2024.1 Builder ..LATTICE

User Guide

8. (Optional) Change the instance name, if desired. Space and special characters are not allowed.
9. Click OK. The schematic block for the module appears in the Schematic view (Figure 2.25).

4. Propel Builder [Cy/Iscc/workspace/EmptyProject/EmptyProject/EmptyProject.skx] Device: LFCPNX-100-9LFG672C Board: CertusPro-NX Evaluation - o x
File Edit View Design Tools Window Help
JERA YCHAD BaRe @Qaa
P Catalog Address & start Page
(oS- 4 -
1P on Local 1P on Server =T
+ [ Processors_Controllers_and_Peripherals [~
Bt System_Memory 111
45t AHB-Lite_Feedthrough 100 . .
5 AHE Lite Interconnect 130 . gpio0_inst
45t AHB Lite to APB Bridge 110 ck i ( \
it APB_Feedthrough 100
45 APE Interconnect 1.1.0
i AXIA to AHE Bridge 100 i 3
5 AXI4 to APB Bridge 100 rstn_i — |+|APELSO
f AXI4 Interconnect 1000 [ | r=-
» [ Verification IP INTP‘|+ —
- _ L=
~ 5 Processors_Controllers_and_Peripherals — ki
@ crio 160 7
@ Risc-vMC 220 gpi0_[Q
© usrt 130 7
= — resetn_i
~
{3 f = nus-E }uus
il equation split concat \ J
>
invert
1P Catalog Design View Al O
Tel Console [m]
% sbp_design open -name EmptyProject -path {C:/lscc/workspace/EmptyProject/EmptyProject/EmptyProject.sbx}
% sbp_design config_ip —vlnv {latticesemi.com:ip:gpio0:1.6.0} -meta loc {C:/Users/jzheng/PropelIPLocal/latticesemi.com ip gpio 1.6.0} -cfg {C:/lscc/
workspace/EmptyProject/EmptyProject/.1ib/latticesend . con/ip/gpiod/1.6.0/gpiod. cEg}
% sbp_add component -vlnv {latticesemi.com:ip:gpio0:1.6.0} -name {gpio0_inst}
L]

Figure 2.25. Propel Builder Schematic View Shows the Module Instance

10. (Optional) To re-generate this IP, double click on the instance. A Module/IP Block wizard pops up (Figure 2.26).

4
Fie Gt Vew Deign Took Windew Hep
sEHAR 9 A mEOE NG @ raQaa =
P Catalog T | shemac dwem sieae
c& -
Wemieal | Famsener v.
B Mosuier® on Lecal
* Modie

b Architectung | MOdule/P Block Wiaard X
v srthmete]  Gonfigure Companent from I gpio Version 161
b 0 Embedded) St the Tukoming saraneiers o configure s camperent.

Memary My
Procesos]  Cigpamppint e
veicaion| == —
F AHBLite
 Clockat  General
B ULRTM Number of 1O Lines [1 - 321 1 R
» Remerve Tri-Seate Butfer ai inst
[re— Intin Output Value hex) [0 - FFFFFFF] | 0
+ £ Processt
- Bubicp 10 Denction (hex) 0 - FFFFFEF] 1
- 3 tcesemi .
r
- 0 Processt Intetace e INTR |
© #o4 PB_S0 TR L-!-J
Aud . ¥ lm
gm clk_i Lo gpio_ie[0:0
© uad gpio_io[0:0]; gpio_ie[0:
gpio
f
A eqution
. + Jrocre o,
[ —
Sesnvien B Cataog . -

oy 10w (1
v app_connect_graup -ports (my,
.

Figure 2.26. Regenerate Module/IP
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11. (Optional) Propel Builder also supports to update all IPs. Choose Edit > Upgrade ALL Ips. Wait a few seconds,
depending on how sophisticated the design is, to see the result (Figure 2.27).

% PropelBulaer Do LECPHO 100-0FGETIC. Board Cotsfro X Ealution @
File Edt View Design Took Window Help
) tndo ez — . . -
P : MEE NS @A  QaaeaaaQ w
[Desigr B Schamatic nddres % Start Page
o
-

Aute Connect

Create Fort
Add Skx Instance

Upgrade All Ps

L
v it Nen

+ [# Companents

Name:  Exampie2
Trpe: Tratarce
Fat: Exampled
WY atbce-systembusider Exampie 1.0

Fit: o

P Catrig Besson vew o

in incerface 'apbO_inst.AP!
£ in incerface ‘apbO_insc. AP

and incerface 'uarco_insc.APB_SO'
¢ and incerface ‘gpiod_tnsc.AEB_SO°

! in interface 'apbd_inst.AP
' in incerface 'apb_inst.APS_MOL

and incerface 'uarco_insc.APB_SO'
and interface ‘gpiod_inac.kEB_S0¢

0 Warming missing driver HDL files
rning missing driver DL files.
Warning missing driver HDL files.

.01 Warning missing driver HDL filea.

O eir9)

Figure 2.27. Upgrade All IPs

2.2.4. Adding Glue Logic

Propel 2024.1 builder supports glue logic modules as well as IP modules. You can add glue logic modules by dragging

them from the IP Catalog view (Figure 2.28) to the Schematic view.

Glue logics be modified afterwards by double click the module.
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IP Catalog O
mE sy

IP on Local IP on Server T-
1 Module/IP on Local
* Module

» EI Architecture_Modules

» EI Arithmetic_Modules

EI Mernory_Modules
» EI Processors_Controllers_and_Peripherals
v [ Verification IP

* |P

» EI Processors_Controllers_and_Peripherals

-

S
34} E f — BUS-E
rtl equation split
}BUS ~[>«:—
concat invert
IF Camlgﬁ Design View

Figure 2.28. Glue Logic Section of the IP Catalog

2.2.4.1. Concat

1. From the IP Catalog, select the concat module. Double-click the concat module or drag and drop concat module to
the Schematic view. A Glue Logic wizard (Figure 2.29) pops up.
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3
i RHS: | BUS[5:0]
LHS: | prsi
B[3:1]
A[5: ﬂ o
B[3: u EUS[S :0] add | Remove
C[0]

oK Cancel

Figure 2.29. Glue Logic for Concat Module

2. Click the RHS (right-hand side) field to change the default right-hand side bus width to a desired one. Click the LHS

Add

(left-hand side) field to change the default left-hand side bus width to a desired one. Click the button to

add LHS (Left-hand Side). Click the Remave button to remove LHS (Left-hand Side). You can only add or remove

LHS but not RHS. LHS and RHS are thus configured.

3. Click OK. The schematic block for the concat module in red appears in the Schematic view (Figure 2.30). you can
drag and connect them with the rest of design.

Schematic Address 4. Start Page

clk_i

rstn_i

m
—
(3]
=
[l
m
[
L7 ]
—
u
(=]
—

Figure 2.30. Schematic View Shows a Concat Module

2.2.4.2. Equation

1. From the IP Catalog, select the equation module. Double-click the equation module, or drag and drop the equation
module to the Schematic view. A Glue Logic wizard (Figure 2.31) pops up.
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<., Glue Logic ? it

Logic Diagram Configuration

Module Mame: = equation_module

Expression: O= A& B

equation_module
0

AR AP

QK Cancel

Figure 2.31. Glue Logic Wizard for Equation Module

2. Click the Module Name field to change the default value to a desired name. Click the Expression field to change
the default expression to a desired one. The expression supports and (&), or (|), negation (!), caret (*). The module
name and expression are thus configured. Expression supports parentheses, as it complies with Verilog-HDL
grammar.

3. Click OK. The schematic block for the equation module in red appears in the Schematic view (Figure 2.32).

Schematic Address 4y, Start Page

equation_module_inst

&

0

cl)m

Figure 2.32. Schematic View Shows an Equation Module
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2.2.4.3.Invert

1. From the IP Catalog, select the invert module. Double-click the invert module or drag and drop invert module to
the Schematic view. The schematic block for the invert module in red appears in the Schematic view
(Figure 2.33).

Schematic Address . Start Page

Figure 2.33. Schematic View Shows the Invert Module

2.2.4.4.RTL
Note: At present, RTL Module only supports Verilog HDL.

1. From the IP Catalog, select the RTL module. Double-click the RTL module or drag and drop the RTL module to the
Schematic view. A Glue Logic wizard pops up (Figure 2.34). Glue Logic supports both Verilog HDL and VHDL. You
can use the drop-down menu to choose a desired language.

%, Glue Logic X

Logic Diagram Configuration

Language: | VHDL -
Use Existing File:

Rtl:  library ieee;
| h 2 use ieee.std_logic_1164.all;
entity h2 is

port(a,b,s : in std_logic;
y :outstd_logic);
end;
—a architecture bhv of h2 is
begin
y <= (s and a) or ((not s) and b);

— b y | end;
| library ieee;
use ieee.std_logic_1164.all; -

OK Cancel

Figure 2.34. Glue Logic Wizard for RTL Module

2. You can edit your own RTL module in the RTL area by entering the RTL module function (Figure 2.34).
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3. Or, you can use an existing RTL module by checking the Use Existing File checkbox. After checking the Use Existing
File checkbox (Figure 2.35), browse to find the existing RTL module file path from the Path filed. If you use an
existing file, RTL references that file from the source. If you do not use an existing file, RTL creates a new file called
<module name>.v. If CopyToDesign is enabled, a copy of the original source is created in the Propel project under
<project>/lib/gluelogics/, if not enabled, it is referenced from its current location.

4 Glue Logic ? x
Logic Diagram Configuration
F
IUse Existing File:
Path: rkspace/test_module 1.v
CopyToDesign:
inv

A[2:0]}-
—{bb[10:8] Bl

oK Cancel

Figure 2.35. Existing RTL Module Configuration
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4. Click OK. The schematic block for the RTL module in red appears in the Schematic view (Figure 2.36).

Schematic Address . Start Page
inv_inst
A[2:0] frmm
=l bb[10:8] B =
C

Figure 2.36. Schematic View Shows the Custom RTL Module

2.2.4.5. Split

1. From the IP Catalog, select the split module. Double-click the split module or drag and drop the split module to the

Schematic view. A Glue Logic wizard (Figure 2.37) pops up.

3 Glue Logic ? X
Logic Diagram Configuration
i LHS: | BUS[5:0]
RHS: Al5:4]
B[3:1]
c[a]
A[5:4]
Add Remove
BUS[5:0](B[3:1]
C[0]
4 [ -
| OK Cancel

Figure 2.37. Glue Logic Wizard for Split Module
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2. Click LHS (left-hand side) field to change the default left-hand side bus widths to a desired one. Click

RHS (right-hand side) field to change the default right-hand side bit width to a desired one. Click the Add

button to add an RHS. Click the Remove button to remove an RHS. You can only add or remove RHS but not LHS.

LHS and RHS are thus configured.
3. Click OK. The schematic block for the split module in red appears in the Schematic view (Figure 2.38).

Schematic Address 4. Start Page

|A_[5:4]

BUS[5:0]}B[3:1]

C[0]

Figure 2.38. Schematic View Shows Split Module

2.2.5. Working with the Schematic View

You can make changes in the Schematic view including automatic layout to clean up the display, moving, resizing,
renaming blocks manually, highlighting objects and zooming the display in and out.

2.2.5.1. View Signal List of Block

rya r=A
I, =
Click the plus sign -!-l of the desired block to see the signals it contains. The plus sign changes to a negative signL-J

| e |
and shows the signal list as shown in Figure 2.39. Click the negative sign:: to close the expanded bus. The schematic

returns to the previous form.
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gpio0_inst

- =,

— E]APB_SD
—{ PpPADDR[5:0]
— p-PENABLE
— <«PRDATA[31:0]
— <PREADY req
INTRL-|-J- —
— PpPSELx -
gpio_iol—
— <4PSLVERR
= pPWDATA[31:0]
—  PpPWRITE
—clk_i
—iresetn_i
", A

Figure 2.39. Signal List of Modules

2.2.5.2. Select One or More Objects
Select one object or more objects in one of the following ways:

e  (Click on the object in the Schematic view. The selected object turns to red (Figure 2.40).
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File Edit View Design Tools Window Help

o= T <=
c=HA M A HEENSE-: 2 QQQa@
IP Catalog o Schematic Address &, Start Page
o & 5
=
IP on Local 1P on Server T
I Module/IP on Local
~ Module

Architecture_Modules
3 Arithmetic_Modules
3 Memory_Modules

hd Processors_Controllers_and_Peripherals

& GPIO 1.6.0 o
& RISC-V MC 210 dk i gpio0_inst
5 RISC-V SM 110 — (- \

5 System_Memory 103
i UART 130 r<=
5} AHB Lite Interconnect 130 rstn_i - | 1APB_S0
5 AHB Lite to APB Bridge 11.0 LI r=-1
5 APE Interconnect 110 INTR|+| —
» [ Verification IP L=
- P s LS
13 Processors_Controllers_and_Peripherals .
gPIC O [
w— resetn_i
~
rtl equation split concat invert
Design View IP Catalog ] v =

Figure 2.40. Select Object
e  Ctrl-click or Shift-click in the Schematic view to select more than one objects.

e (Click the Area_select icon L from the Propel Builder Toolbar. Click and drag to draw a selection rectangle around
the modules and ports in the Schematic view. Click the icon again to turn off the Area_select mode.
e  From the Schematic view, right-click and choose Select All or press Ctrl-A to select all the objects.

Note: Ctrl-click or Shift-click on the object in the Schematic view can also de-select the object while leaving the others
selected.

2.2.5.3. Re-arrange the Schematic

Propel Builder allows re-arranging the objects in the schematic view. You can re-arrange modules and ports. Drag

objects to re-arrange the schematic. Propel Builder has rules for placing objects to adjust the schematic in an organized

arrangement.

1. Select the desired modules (one or more modules can be dragged at the same time) or ports (one or more ports
can be dragged at the same time).

2. Click on the selected items and drag it/them to the desired location.

3. Release the mouse button.

Note: The selected objects can be moved to a specified location, or near the existing object (as near as the rules allow).

Other objects in the schematic can also be moved to accommodate the new location of the selected objects.

To bring selected objects to the center of the Schematic view using the Locate Object mode:

e

1. Click the Locate Object icon “:” from the Propel Builder Toolbar. The background turns to dark gray.

2. Select the object in the List view of the Design View. The selected object is in the center of the Schematic View
(Figure 2.41).
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File Edit View Design Tools Window Help

s=HA M A BMEE xGEHE-: & QQaQa
Desemiliew g Schematic Address v Start Page

I8 LFCPNX-100-9LFGET2C
= 1 EmptyProject
» 2 Ports
A 1? Instances
v 1F gpiod_inst
v [ Components

rstn_i

i[> p .

[
ry
i+

5

‘U.'.l

3
I

Properties
Name: | gpio0_inst
Type: Instance

Path: EmptyProject/gpio0_inst
VLNV: latticesemi.com:ip:gpio0:1.6.0

Design View 1P Catalog 4

Figure 2.41. Locate Objects

To automatically simplify the layout:

1. Right-click anywhere in the Schematic view and choose Relayout.

2.2.5.4. Duplicate a Module

Select the desired module and click Clone . Or right-click on the module and choose Clone . A copy of the
schematic block appears with a new instance name (Figure 2.42). It creates a separate copy of the original module
using all the same settings and is essentially its own component which can be modified and managed separately.

gpio0_inst gpio0_inst O
' ™ ' ™
= i1 APB_S0 _ = i1 APB_S0 _
B INTR o] o B INTR oo} e
—clk_i B —clk_i -
gpio_iop— gpio_iop—
—{resetn_i —{resetn_i
b J b J

Figure 2.42. Duplicate a Module
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2.2.5.5. Restore a Deleted Module
1. In the List view of the Design View (Figure 2.43), go to the Components folder. The deleted module can still be
found in the List view in plain text. Those not deleted are shown in bold-faced text.

m|

Design View
18 LFCPNX-100-9LFGET2C
= 1F EmptyProject
K 3:- Ports
A iﬁt Instances
v 1E gpiol_inst
v 1 gpio0_inst_0
= |i¥| Components
|| gpiot:1.6.0
|| gpiol_0:1.6.0
|E| apb0:1.0.0

Properties
MNarme:

Type: Instance

Path: EmptyProject

VLMV  lattice:systembuilder :EmptyProject: 1.0

File:  C:flsccfworkspace EmptyProject/EmptyProject/EmptyProject. sbix

IP Catalog Design View

Figure 2.43. Design View

2. Right-click on the component you want to restore, and choose Instantiate. The Define Instance dialog box
(Figure 2.44) open.

. Define Instance ? >

Instance Mame: apbd_inst
Instance Reference: apb0:1.1.0
OK Cancel

Figure 2.44. Define Instance Dialog Box
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3. Enter a name for the new instance.

4. Click OK. The module appears in the Schematic view and the List view of Design Info, and the component name is
bold-faced.

2.2.5.6. Reconfigure a Module

1. Double-click the module, or right-click the module you want to reconfigure. Choose Reconfig. The Module/IP Block
wizard (Figure 2.45) opens.

4, Module/IP Block Wizard X

Configure Component from Module apb_interconnect Version 1.1.0
Set the following parameters to configure this component.

Diagram apb0 Configure IP
General Main Settings Master Priority Settings
Property Value
~ General
Total APB Masters [1 - 32] 2
Total APB Slaves [1 - 32] 2
Master Address Width(bits) 32
apb0
Data Bus Width(bits) 32
—4HAPB_s00
—aPB_S01  APB_MOGHH—
—{apb_pdlk_i APB_MO14H~
—apb_presetn_i

apb_interconnect

4 » Mo DRC issues are found.

Generate Cancel

Figure 2.45. Module/IP Block Wizard — Configure Component

2. Configure component (including General property, Main Settings and Mater Priority Settings) at Configure IP table
in the Module/IP Block Wizard. Click Generate to generate the module as usual. The schematic block for the
module changes to match the new configuration.
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2.2.5.7. Resize Module Blocks
1. Select the desired module block. The block is highlighted in red with black corners (Figure 2.46).

|— apb0_inst _l
== IHAPB_S00
=i HAPB_S01  APB_MOO -} fee
—{apb_pclk_i APB_MO1 [} je=

—lapb_presetn_i
IS - |

Figure 2.46. Select Module

2. Click and drag one of the corners to change the size and to shape of the block.
3. Release the mouse button. All the other objects move to make room for this block.
Note: Right-click the module block and choose Unresize Instance to restore the size of the module block.

2.2.5.8. Methods to Zoom

There are a variety of methods to zoom within the Schematic view including toolbar commands and dragging in the
Schematic view.

The following commands are available from the Propel Builder Toolbar.
e Zoom In (Ctrl++) @ — enlarges the view of the entire layout.
e Zoom Out (Ctrl+-) Q — reduces the view of the entire layout.

e Zoom Fit — reduces or enlarges the entire layout so that it fits inside the window.
l/h\
e Zoom To A _ enlarges the size of one or more selected objects on the layout and fills the window with
selection.

Note: The mouse wheel provides a finer zoom control by rolling the mouse wheel forward to zoom in and backward to
zoom out while pressing the Ctrl key.

e Tozoom by holding the mouse button and dragging.
e Tozoom to fit the window, drag up and to the left. The image adjusts to fill the window.

e Tozoom out, drag up and to the right. The dragging distance determines the amount of zoom. The image is
reduced and centered in the window.

e Tozoom in, drag down and to the left. The dragging distance determines the amount of zoom. The image is
enlarged and centered in the window.

e Tozoom in in a specific area, start at the upper-left corner of the area and drag to the lower-right corner of the
area. The area that dragging across is adjusted to fill the window.

Note: Make sure that the Area_select icon d is not selected in the Toolbar. If you need to use Area_select and zoom
by dragging frequently, choose Tools > Options from Propel Builder menu bar. The Options Dialog opens (Figure 2.47).
Select Use right mouse button for zooming actions and click OK. Then you can select an instance using the left mouse
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button, zoom in or zoom out using the right mouse button, and the Area_select icon i disappears from the Propel

Builder Toolbar.

qh

Themes: Light

General Color Nebwork Settings Directories

Use right mouse button for zooming actions

Automatically connect after instantiating an instance.

0K Cancel

Set Default

Apply

Figure 2.47. Options Dialog

2.2.5.9. Move a Schematic Image
You can move a schematic image within the Schematic view by panning and scrolling:

e To pan the image: Hold down the Ctrl key and the left mouse button while dragging the image.

e To scroll vertically: Rotate the mouse wheel. Or click in the vertical scroll bar.

e To scroll horizontally: Hold down the Shift key and rotate the mouse wheel. Or click in the horizontal scroll bar.
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2.2.5.10. Show the Connectivity of a Module

Right-click the module and choose Show Connectivity. All nets connected to the module, all pins and ports connected
to the nets are highlighted (Figure 2.48).

File Edit View Design Tools Window Help

s 5 DC A BEENSAXNRNS QQ Q@
Design View o Schematic Address &, StartPage
0 LFCPNX-100-9LFGE72C =
~ I HelloWerld
= {F Instances
» IE ahblo_inst

b iF ahbl2apb0_inst
v 1E apbl_inst
» 1E cpullinst
» 1F equation_module0_inst
» 1E gpiodinst
» I oscO_inst
» IE plio_inst
v IE sysmem_nst
» IF vartdinst
» 2= Ports
> Nets
> Components

ot et

Fren *PRI0L

Properties

Name: | cpu0_inst

Type: Instance
Path:  HelloWWorld/cpud_inst
VLIV:  latticesemi, com:ip:cpu0:2, 1.0

IP Catalog Design View

Figure 2.48. Show Connectivity of the Module

2.2.5.11. Highlight an Object

2 2
Select an object and click Highlight , or, right-click the object and choose Highlight . The object is highlighted

<
in blue (Figure 2.49). Click Highlight = again. You can remove highlighting. In Tools Options section, you can change
the highlight color.

gpio0_inst

HAPB_S0 i
== INTRIA
clk_i -

gpio_io
resetn_i

Figure 2.49. Highlight an Object
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2.2.5.12. Change the Name of an Object

1. Select the object from List view of the Design View. Information of the selected object is shown in the Properties
area (Figure 2.50).

Properties
Mame: | gpiol_inst

Type: Instance
Path: HelloWorld/gpiod_inst
VLMV:  latticesemi.com:ip:gpio0: 1.6.0

Figure 2.50. Object Properties

2. Change the name and click Enter. The name changes in the Schematic view and List view of Design Info.

2.2.5.13. Print a Schematic

1. Choose File > Print Preview. The Print Preview window (Figure 2.51) opens.

&, Print Preview: Schematic ? ®

s&s%‘e\@\ @-4:4: 111$$'ED i b

Figure 2.51. Print Preview

2. Expand the Print Preview window to the desired size.
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3. Click the Page Setup button r and adjust the paper size and margins, if necessary.

ridy
4. Click the Print button ™ .

5. Adjust the printer settings, if necessary. Click Print.

2.2.6. Connecting Modules

You can connect the pins of modules to other modules or to top-level ports by dragging a line between them or by
selecting connection points, or by assigning a constant value to an input pin or bus. Propel Builder does not allow
obvious inappropriate connections, such as a connection between two output pins or mismatched buses.

2.2.6.1. Connect Modules by Drawing

1. Move the cursor to a pin or port. The cursor changes to a pencil icon 17 click and hold while dragging to another
pin, port, or net. An allowed pin or port shows a green checkmark when you hover over it
(Figure 2.52). An allowed net becomes bold when you hover over it (Figure 2.53).

apb0_inst
== P2 ~\ gpio0_inst
= 1==1APB_S00 V 1APB_S0
= i | I — ry
— Ir-l-l APB_S01 APB_MUUL+_= L=d INTRL+JI
L_}: i ~ clk i -
—apb_pelk_i APB_MO1 ] frmee io_io
: - '-!-' resetn_i PO
—apb_presetn_i
. )
Figure 2.52. Draw a Pin or a Port
. sysmemO_inst
cpu0_inst e,

( S
—FHIRQ_SO
—FHIRQ_S1
—FHIRQ_S2
—FFIRQ_S3AHBL_MO_INSTRE =
—FFIRQ_S4 AHBL_M1_DATAFF}—
~FBIRQ_S5 TIMERZIRQ MOFF~
—~FIRQ.56  system_resetn_o\—
_—FFIRQ_S7

clk_i | clK_i
rstn_i rst_n_i

A J

FAHBL_S0
—FFAHBL_S1
_—ahbl_hclk_i

ahbl_hresetn_i

S ——

Figure 2.53. Draw Nets

2. Click on the pin, port, or net that you want to connect to. If the connection is allowed, a line appears connecting
the two objects. Propel Builder creates a path around other objects.
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o—

B |
3. You can connect multiple ports once. When more than one port is selected (Figure 2.54), click connect = from
the right-click menu to implement it.

=hblo_inst

FFAHEL_S00
zhbl

ahbl_hresetn_j

~" AHBL_MODE]

ahbl2apbld_inst

. AHBL_MO1EE]

cpul_inst

HFIRGQ_SBEL_MO_INSTRAF

HFIRQ_SHEL MI_DATALE

rst_n_i

ki TIMER_IRQ_MOFF

FF AHBL_S0
| i APE_MOHE
st m_i

HF APE_S00
=nh

i
w3pb_preset

apb0_inst

APE_MOOZE|
_ APB_MOLFF

o=l _inst

by hf_out_en i hf_ck_out_o

—{ o td o
— led_o[7:0]

Figure 2.54. Select More than One Ports

4. When the connection is completed, right-click to leave the drawing mode.
Pin/Net/Pinlface/Netiface display filter:

Click the

Schematic Address

vt i[>

plo_inst
i clkop_s

cpun_inst.

s1_uart_rxed i[>

i lock_of

equation_module_inst
@

[— FFIRQ_SALOCAL BUS M1

HFIRQ ST ANI_M_INSTREE

systemD_inst
FFad1_50
axi_ack i
resetn_i

tem_jnst

e _systemPCAL BUS_M I

F _BUS_IF_SH

AL

_BUS IF 5|

i
Ik _realtime_i

system_resetn ¢

_clk

s

Wy icon on Schematic view, the filter shows. By clicking it again, filter hides.

B ifins
M pinlfaces
Nets
Netlfaces

axitx2 st

avilzapbl inst

e o i AL S0 s0_aph_gpio_inst,
A AHIL_MOOEF - 5 _ANI_ARESETIARE_MICHE FFARB_S0 e
ki 1
i AL 5 _pr_Ack ok i
i Sy e i SO

wil2apb0_inst

FFANIL_S00

avilzapt
5_AKL_ARESETIAPE_MOCH
S_ARL_ACLK

Figure 2.55. Pin/Net/Pinlface/Netlface Display Filter
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When Pin/Pinlface is hidden, the connection is hidden. The hidden status is not to be saved in design. It is only used
to view design easily.

Sthematic Address & Start Page

{8
[ Pinlfaces
Mets

system0_inst [ Netlfaces

HFAX1_S0!

ol st cpud_inst
rstni =
- o ANL_MLINSTRAE bem0_inst
HFIRQ_S3LOGAL_BUIS_M_DATA

eguation_module_inst
HFIRQ_S10CAL BUS_M_INSTRAF, FFLOCAL BU IF 5
oscO_inst IR PUS M FFLOCAL_BUS_IF S
( ) AHL_M_DATATF
_ 2l st __ aslzaphl_inst
i ]
b ANIL_MO0FE - FFANIL_S00 APE_MOGFF #0.2pb_gpio._inst
L maxso ]
1 AL

[Ep—

axilzapb0_inst

HFAKIL_S500 APE_MOOF 51_aph_uart_inst

FFAPB_SOINT_MOFF

si_vart_pee i

Figure 2.56. Pin/Pinlface is Hidden

2.2.6.2. Connect Modules by Selecting Points
1. Select the pins, ports, and nets you want to connect, using Ctrl + Left click.

2. Right-click one of the selected objects. Choose Connect — from the menu, and the objects will be connected.
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2.2.6.3. Connect Pins by Auto Connect

1. Right-click on Schematic view and choose Auto Connect (Figure 2.57). The Connect Ports dialog appears
(Figure 2.58).

systemO_inst

Pt b — sl
— FRAHBL_S0
—{HHAHBL_S1
—ahbl_hresetn_i
—ahbl_hclk_i

S

Create Port
I Auto Connect I

Create Comment
ﬁ Validate Design
Select All

Relayout

Figure 2.57. Action Menu of Right-clicking on a Blank

2. By default, Auto Connect selects all ports. You can also deselect the interface/clock/rest pins that you do not want
to auto-connect (Figure 2.58).

3. Auto Connect can only connect one of its suggested sources at a time. For example, for PLL connections, we can

only select clkos_o or clkop_o to connect to multiple destination ports, but we cannot make those connections at
the same time.
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4., Connect Ports x

Driver Destination
Clock/Reset Connection
oscl_inst/hf_dk_out_o pli0_inst/clki_i
osc_instIf_dk_out_o
pllo_inst/ckop_o

pllo_inst/ckos_o

rstn_i pll0_inst/rstn_i

cpul_inst/system_resetn_o

Interface Connection Clock: | oscO_inst/hf_dk_out_o + | Reset: |rstn_i -
0 inst/AHEL M1 DATA hbI0_inst/AHBL_S00 Clock: K4 ahbio_inst/afbl_hekJ
cputn - anebns - Reset: ahbld_inst/ahbl_hresetn_i
HbI0.inst/AHBL MO0 bbi22pb0, inst/AHBL_S0 Clock: ahbl2apb0_inst/dlk_i ahbl2apb0_inst/pdlk_i
2 -n - @ poEns - Reset: ahbl2apb0_inst/presetn_i ahbl2apb0_instfrst_n_i
hbl2aph0,_inst/APB_MO b0,_inst/APB_500 Clodk: K4 apb0_inst/apb_pdlc i
2 appEn - apeb.ins - Reset: apb0_inst/apb_presetn_i

Clodk: sysmem0_inst/ahbl_hdk_i
hbl0_inst/AHBL_MO1 hd 0_inst/AHBL_S0 - .
2 inst/. - &2 sysmem0_inst/ - Reset: sysmem_inst/ahbl_hresetn_i
Clack: apio0_inst/dk_i
b0_inst/APE_MOO a4l gpio0_inst/APE_S0 - -
apb0_inst/ - . gpio0_instfAPB. Reset: gpio0_instjresetn_i
Clack: uartd_inst/dk_i
b0_inst/APE_MO1 a4l uartd_inst/APE_S0 - -
apb0_inst/ - . uartd_inst/APB. Reset: uart0_instfrst_n_i
Clock: cpul_instdk_i
io0_inst/INTR 7 0_inst/IRQ_S0 - -
gpiol_inst/| E cpuo_nst/Rq. Reset: cpul_instfrst_n_i
Clock: cpul_instdk_i
rt0_inst/INT_MO 7 0_inst/IRQ_S1 - -
uart)_inst/INT | . Pu0_InstIRQ Reset: cpud_instfrst_n_i
Others
rxd_i uartd_inst/red_i
uartd_inst/txd_o txd_o

OK Cancel

Figure 2.58. Action Menu of Connecting Ports

Auto Connect Rules

Auto Connect can initialize three types of connections: Clock/Reset connection, Interface connection, and other
connection.

A. Clock/Reset Connection

For clock/reset connection, you can choose only one clock port and one reset port in the Driver selection area.
In the example below, you can choose only one clock port from oscO_inst.hf_clk_out_o, pll0_inst.clkop_o, or
pll0_inst.clkos_o, and one reset port from cpuOQ_inst.system_reset_n_0 or rstn_i (Figure 2.59).
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4. Connect Ports

b4
Driver Destination
Clock/Reset Connection
oscl_inst/hf_dk_out_o 2 plio_inst/clki_i
oscO_instf_ck_out_o
pllo_instfckop_o
pllo_inst/dkos_o
rstn_j plll_inst/rstn_i
cpul_instfsystem_resetn_o
Interface Connection Clock: | oscO_instfhf dk_out o+ Reset: |rstn_i -
0_inst/AHBL_M1_DATA hbl0_inst/AHEL_500 Clock: K4 ahbid_inst/ahbi_hlk1
PN - anblns - Reset: ahbld_inst/ahbl_hresetn_i
hbl0. inst/AHBL MO hbl22pb0_inst/AHEL_SO Clock: ahbl2apbd_inst/ck_i ahbl2apb0_inst/pclk_i
2 -n = = - - Reset: ahblZapbd_inst/presetn_i ahblZapb0_inst/ret_n_i
Clock: apbi_instfapb_pdk_i
hbl2apb0_i APE_MOD hd 0_inst/APB_S00 - -
2 apb0_inst/APE | &2 pbo_inst/ape_ Reset: apb0_instfapb_presetn_i
Clack: sysmem0_inst/ahbl_hdk_i
hbI0_inst/AHBL_MO1 L 0_inst/AHBL_S0 - T
2 inst/ - . sysmem0_inst/ - Reset: sysmemi_inst/ahbl_hresetn_i
Clock: gpio0_instfdk_i
b0_inst/APB_MOD w4l gpio0_inst/APB_S0 - -
apb0_inst/ - . gpio0_inst/APE. Reset: gpio0_instfresetn_i
Clock: vartd_inst/dk_i
b0_inst/APB_MD1 » t0_inst/APB_S0 - -
apb0_inst/ - . uartd_inst/APE_ Reset: vartd_inst/rst_n_i
Clock: cpud_inst/dk_i
o0 IMNTR v 0_i RQ_S0 - -
gpioD_inst/ & cuo_nst/rq Reset: cpud_instjrst_n_i
Clock: cpud_inst/dk_i
e i INT_MO hd 0_i RQ_S51 - B
uartd_inst/INT. & cpuo_inst/RQ Reset: cpud_instjrst_n_i
Others
rxd_i B uartD_inst/red i
uartd_instftxd_o ted_o

oK Cancel

Figure 2.59. Select One Clock/Reset Port

Following are rules of how clock/reset driver port auto connects to the destination:
a. Whether or not the SoC project contains a CPU instance.

e Ifthe SoC project contains a CPU instance, and the CPU instance has an output clock/reset port, such as

cpu0_inst.system_resetn_o (Figure 2.60), the clock/reset of other instances are thus connected to the
clock/reset port of the CPU Instance (Figure 2.60).
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rstn_i pll0_inst/rstn_i
cpul_inst/system_resetn_o
Interface Connection Clock: | oscO_inst/hf ck_out_o = Reset: |rstn_i v
0 inst/AHBL_M1_DATA hblo_inst/AHBL_S00 Clock: K4 anbio_nst/abl_hck J
cpuEm . anblbns - Reset: ahbl0_instfahbl_hresetn_i
hbl0. inst/AHBL M0D hbl2apb0_inst/AHEL S0 Clock: ahbl2apb0_inst/dk_i ahbl2apb0_instfpclk_i
i - = —— - Reset: ahblZapb0_inst/presetn_i ahbl2apb0_inst/rst_n_j
hbl2apb{_inst/APE_MO b0_inst/APE_S00 Clock: apb0_inst/apb_pck |
2 aphum - aph_ns - Reset: apb0_instfapb_presetn_i
Clock: sysmem0_instfahbl_hdlk_i
hbI0_i AHBL_MO1 b 0_inst/AHBL_50 ” -
2 inst/ - . sysmemd_inst/ - Reset: sysmem0_instfahbl_hresetn_i
Clodk: gpioD_inst/dk_i
b0 i APB_MODO w4l gpio0_inst/APB_S0 ” B
apb0_inst/ - . gpioD_Inst/APE Reset: gpio0_inst/resetn_i
Clock: uartd_jnst/dk_i
b0 i APB_MO1 hd t0_inst/APB_S0 - B
3pb0_inst/ARE_ B2 arto_inst/ape_ Reset: uartd_jnstfrst_n_i
Clodk: cpul_inst/dk_i
iol_i INTR b 0_i RQ_S50 B -
gpiol_inst/| [ cpuo_inst/IRG_ Reset: cpul_instfrst_n_i
Clodk: cpul_inst/dk_i
el i INT_MD hd 0_i RQ_51 - B
uartd_inst/INT_ B2 cpuo_inst/iRQ Reset: cpud_instfrst_n i

Figure 2.60. Connecting CPU Instance Reset Output Port

e |fthe SoC project does not contain a CPU instance, clock/reset on all instances connect to the top clock/reset
port. Top clock/reset port is the port such as rstn_i in Figure 2.60.

b. The output clock/reset port on one instance should not be connected to its own clock/reset input port. For example,
cpuO_inst.system_resetn_o should not connect to cpuQ_inst.rst_n_i in Figure 2.60.
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B. Interface Connection

Bus interfaces can only connect from one interface to another. It is a one-to-one relation, not a one-to-multiple
relation. And the interfaces must have the same interface type.

In the example below (Figure 2.61), cpuO_inst. AHBL_M1_DATA is a bus interface. It can only connect to one
destination, ahbl0_inst. AHBL_S00, because they have the same interface type AHBLite. To know the interface type, you
can check the Bus Type in Design View (Figure 2.61).

Destriiew L= Schematic Address %, startPage
» & AHBLM1_DATA [+ r
» 9 IRQLSD
» oD IRQST
» (& TIMERIRQ_MO
» F equation_module_inst
» iF gpieliinst
= 1} oscOinst
» G Ports
v L plio_inst
b o Ports
v TF systemOinst
b T} uartOinst

~ [#] Components
[ cPLD_interfacel:1.1.0
[ cpu0:2.2.0
[ gpio0d:1.6.0
[ GPIO1:1.40
[ 12€ filter0:1.0.0
[ Pico.0.0
[ sFrBo:1.00
[ SFB_interface0:1.0.0
[ system0:1.1.1
[ uart:1.1.0
[ uarte:1.3.0
[ ahbio:1.1.2 8

Properties
Name: AHBL_M1_DATA
Type: Piniface

path: tts/cpu0_inst/AHBL_M1_DATA [+

IP Catalog Design View a S

Figure 2.61. Interface Type of cpu0_inst. AHBL_M1_DATA

Interface Connects Rules

If a project contains a CPU instance, the interface connection starts from the CPU instance, then to one bus/bridge
instance, and then to another bus/bridge instance. After connecting all bus/bridge instances one by one (cpu0 > ahbl0
> ahbl2apb0 > apb0), finally connects to other instances (gpio0, uart0). See Figure 2.62 and Figure 2.63.

system0_inst

gpio0_inst

cpul_inst ahbl0_inst
J —ouomst —_—— uart0_inst
F3 IRQ_S0AHEL_MO_INSTRER t} AHEL_S00 P | - «
:E"’Q;SIAHBLJAI?DATAH bl_hresetn_i - o] jned =
AHBL_MO1EE ki INT_MOFR
Ik_i TIMER_IRQ_MOFE pem bl_hck_i hbRapb. inst | . o
st system_resetn_ L po0_in: 1 ;"_J |_o|
i

apb0_inst

Figure 2.62. Interface Connection on from CPU to Bus/Bridge instances in Schematic View
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Interface Connection Clock: | oscO_inst/hf _ck_out_o = Reset: | rsin_i -
0_inst/AHBL_M1_DATA hbl0_inst/aHBL_S00 Clock: ahbl0_inst/ahbl_hok |
cpusIn - T =il ins - Reset: ahbl0_instfahbl_hresetn_i
hbI0. inst/AHBL MOD Hblaphd, inet/AHEL SO0 Clock: ahbl2apb0_inst/dk_i ahbl2apb0_inst/pclk_i
? -n - = — - Reset: ahbl2apb0_inst/presetn_i ahbl2apb0_inst/rst_n_i

hbl2apb0_inst/APB_MO b0_inst/APB_S00 Clock: 4 2pb0_nst/zpb_pclk
z aphL-In - Fpaans - Reset: apb0_instfapb_presetn_i

Clock: sysmemQ_instfahbl_hdk_i

hbl0_inst/ AHBL_MO1 hd 0_instfAHBL_S0 - -
? inst/ - B sysmem0_inst/ - Reset: sysmemQ_inst/ahbl_hresetn_i

Clock: apio_inst/dk_i

b APB_MOD v oD _il APB_S0 - B
3pb0_inst/ - . gpiod_inst/APE Reset: gpio0_instfresetn i

Clodk: uartd_instfdk_i

b0_inst/APB_MO1 hd t0_inst/APB_S0 - -
3pb0_inst/APE_ B uarto_inst/APe Reset: uartd_instfrst_n_i

Clocks cpud_inst/dk_i

io0_inst/INTR hd 0_i RQ_S0 - B
gpicl_inst/ B cpuo_inst/IRQ_: Reset: cpul_inst/rst_n_i

Clodk: cpul_instjdk_i

rtd_inst/INT_MD hd 0_i RQ 51 - -
uartO_inst/INT.| & puo_inst/RQ. Reset: cpud_instfrst_n_i

Figure 2.63. Interface Connection from CPU to Bus/Bridge Instances in Connect Port View
If the last instance connected has the same bus interface type as that of the CPU instance, then it connects back to CPU

instance (see Figure 2.64 and ). In Figure 2.66 and Figure 2.67, you can see gpioO_inst.INTR and cpu0_inst.IRQ_SO have
the bus type: Interrupt.

system0_inst

-
£

gpio0_inst

= FHAHEL 51

—J cpul_inst ahblo_inst I
—_—
FHIRQ_S0AHEL_MO_INSTRER] FAHBL 500 T |
FRIRQ_SLAHEL_M1_DATAL ibl_hresstn_i -
ki TIMER_IRQ_MOF3] ibl_helk_i -t |
‘ —IrsLnj system_resetn_ |
i

apb0_inst

Figure 2.64. Interface Connection on Other Instances Connecting back to CPU in Schematic View
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Interface Connection Clock: | oscO_inst/hf_dk_out_o ¥ | Resetr |rstn_i -
0_inst/AHBL_M1_DATA hblo_inst/AHEL_S00 Clock: 14 ahbib_inst/anbl_hekcJ
cpusn - anbibins = Reset: ahblo_inst/ahbl_hresetn_i
hbl0_inst/AHBL MOD bl 2apb0,inst/AHEL SO Clock: ahbl2apb0_inst/clk_i ahbl2apb0_inst/pelk_i
anbien - # e - Reset: ahbl2apb0_inst/presetn_j ahbl2apb0_instfrst_n_i

Clack: apb0_inst/apb_pdk_i

hbl2apb(_inst/APB_MD ol 0_inst/APE_S00 - B
ahbl2apb0_inst/APE | 2 2pbo_inst/aPe Reset: apb0_inst/apb_presetn_i

Clock: sysmem0_inst/ahbl_hdk_i

hbl0_inst/AHBL_PMO1 ol 0_inst/AHBL_S0 - T
2 -inst/ - . sysmem0_inst/ - Reset: sysmem0_instfahbl_hresetn_i

Cladk: agpio0_inst/dk_i

b0_inst/APB_MOD | gpio0_inst/APB_S0 - B
3pb0_inst/APE 2 gpioo_inst/aPe. Reset: gpio0_instjresetn_i

Clock: uartd_inst/ck_i

b0_inst/APB_MO1 ol t0_inst/APB_S0 - B
apb0_inst/APE | B uarto_nstyaps Reset: uartd_inst/rst_n_i

Clock: cpul_inst/dk_i

io0_i INTR bl 0_i ROQ_S0 - -
gpiel_inst/ & cpun_inst/IRQ Reset: cpul_instfrst_n_i

Clock: cpul_inst/dk_i

i IMT_MO ol 0_i RQ_S51 - B
uart0_inst/INT_| & cpun_inst/IRQ Reset: cpul_instfrst_n_i

Figure 2.65. Interface Connection on Other Instances Connecting back to CPU in Connect Port View

Design View a
» (+ AHBL M1_DATA |
» D IRQSO
b RQST
b G TIMERIRQ_MO
» 1 equation_module_inst
v 1F gpio0_inst
b Ports
v 2 Buslnterfaces
» 0 APE.SD
» & OINTR
~ 1F oscllinst
b 25 Poits
v 1F plioinst by
» 2= Ports

e
» 1 system_inst

b uatinst e pljet L 1
i Nas N _—— ] s

- Components D T
[ CPLD interface0:1.1.0 il - —L
[ cpu02.2.0 I
[ gpio0:1.6.0
[ GPIO1:1.40
[ 12 filter:1.00
[ Pice:1.00
[ sFBo1.00
[ SFB_interfaced:1.0.0

Schematic Address % Start Page

»
»

Name: INTR

Type: Piiface

Mode: Master

Pat tts/gpiod_inst/INTR v
IP Catalog Design View

Figure 2.66. Interface Type of gpio0_inst.INTR
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Design View Schematc Address. %, Start Page
v RO i
v ROST
o TIMER_JRQ_MD
equation moduleinst
apiod_nst
2 pors
- Businterfaces
< APESD
N
ascljnst
pll_inst
» 10 systemi nst

Figure 2.67. Interface Type of cpu0_inst.IRQ_SO

If the project does not contain CPU instance, the interface connection starts from the bus/bridge instance, and then to

each bus/bridge instance one by one, and finally connects to the other instances.
Note: If the bus interface is an instruction set, such as CPUO_inst. AHBL_MO_INSTR, it does not perform auto-connect.

C. Other Connection
If ports have the same port name, for example, rxd_i and uartO_ins.rdx_i, they are auto connected.
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2.2.6.4. Assign a Constant Value to an Input Pin
1. Select the desired pin and right-click the pin. Choose Assign Constant Value (Figure 2.68).

osc0_inst

L hf_clk_out_n]—

Copy Full Path

2 Highlight

Disconnect
Assign Constant Value

Create Port

Add Sbx Instance

Auto Connect

Create Comment
§ Yalidate Design

Select All

Relayout

Figure 2.68. Right-click Menu of an Input Pin

2. A small dialog box appears (Figure 2.69). Enter the desired value. To erase the value and start over, click X. For all
buses (more than one pin), the format is hexadecimal. Make sure the value fits the number of pins in the bus. For
example, a 3-pin bus can accept 0-7, but not 8.

osc0_inst
1'b1],, . hf_clk_out_o
—out_en_| E Alls ek -~
Assign constant value:
ob1 W

Figure 2.69. Dialog Box of Assigning Constant Value to an Input Pin

2.2.6.5. Disconnect Modules

Usually, disconnecting modules means deleting a net. If the net has multiple branches, just delete one branch, leaving
the rest of the nets intact.

e Todisconnect one branch of a net, right-click the pin of that branch and choose ~ Disconnect. The branch going
to that pin disappears.

e Todisconnect a whole net, right-click the net and choose Delete. The whole net is deleted.
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2.2.7. Creating Top-level Ports

With multiple modules in a Propel Builder project, top-level ports need to be created for a complete Propel Builder
module. You can create a top-level port either manually or automatically.

For input ports that connect to more than one pin, such as for clock and reset signals, the manual way is more
convenient than the automatic way. If the port names automatically-generated need to be changed, the manual way is
better.

For other pins, the automatic way is usually preferred. The automatic way enables you to create the appropriate port
type and connect net simultaneously. The automatic way can also create multiple ports at the same time.

The automatic way of creating ports is the most effective. If all the modules are selected, Propel Builder can
automatically create ports for all the remaining unconnected pins for selected modules in one step.

e To create a port for a pin or bus manually:

a. Right-click in the Schematic view and choose Create Port. The Create Port dialog box pops up
(Figure 2.70).

s, Create Port x
Mame: input_part
Direction: in =
Type: General -
Bus Options:

oK Cancel

Figure 2.70. Create Port Dialog Box

b. Enter a name for the port in the Name field.
Choose a direction for the port, such as Input in the Direction field.
d. Choose the port type from the Type field. The default type is General.

e. (Optional) Select the Bus Options. Enter the number for the most significant bit (MSB) and the least significant
bit (LSB). These two options define the bus width.

f.  Click OK. The port appears. Figure 2.71 shows an input port, port name of which is on the left. Figure 2.72
shows an output port and an inout port, port names of which are on the right.

input_port [ >

Figure 2.71. Input Port

{_> Inout_port
[ output_port

Figure 2.72. Output Port and Inout Port

g. Connect the port to the module pins. Refer to the Connecting Modules section for more details.
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h. (Optional) Double click on the Port/ Portbus in schematic view, will open the port edit dialog (Figure 2.73).

Fle Edit View Design Tooks Window Help

s B A M@ xS @ o Qaaa
Design View o Schemaiic Fekb 3% Start Page
8 LFD2NX-40-88G256C
= 40 et &
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v % shbi0_inst o
b 1 ahbl2apbl_inst
v IF apb0inst |
v I cpudinst rstn_i[_— ahbla_inst bd_o
v I equati duled inst O
. & ::‘:Dj:;m - e ahbl2apb_inst I O
» I oseljnst e so & Edit Pert x
v T pi0inst i
v [} sysmemiinst stnl AP Mame:  led_oal
v 1 vartd inst 3 19
- % Pors Directen: | nout -
: 3 I;d_nL?:V] Type: General -
\ﬂdﬁl CpuD_inst BusMsB: 7
v i e fmgst Ao sTREE B0 jnst Bustst: |0
» [# Compenents TERO_S0 AHBL_M1_DATACE) e B o Cancel
‘ TIMER_IRQ_MET= Y S
Fronertes M ) system_resem < Y dos o
Hame: led_o
Tiee:  portus I
= 7 gpiod_inst
Drecton: | nout - 1] g 1by hf_ci ot g
. ool thf_out_en s
Path: testhed o 3} If_ck_out_o
Povaks [N .
Figure 2.73. Port Edit Dialog
e To create ports automatically:

a. Select the pins that are to be connected to the top-level ports. All the pins in a module can be selected by

b. Right-click on one of the selected pins, interfaces or modules, and choose
extended by lines to new top-level port symbols. The names of the ports and nets are added to the List view.

clicking its block. Any pins that are already connected to a net or a constant value are skipped.

C

Zoom out or scroll the image in the Schematic view to see the new ports.

c. Portor net names can be changed, if needed.

To modify a port:

a. Click on a port, Properties window open (Figure 2.74).

. Propel Buildes Device: LFCPNA-100-9LFGET2C Bowrd: CertusPro-Hik Evaluation () - a8 x

Eile Edit View Design Took Window Help

+2 8 A WMEE NS @A o aaaaq
Do e B bt adbes % st pase
B LRCPH-100-0L G872 o

Th D:/Ge3kCop/uIDACE_Teat/BelloRorla/HelloNorLa/He1loRoT1d , abR1

Figure 2.74. Properties of Port

’Export. The selected pins are
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b. Port direction can be modified. You can use the drop-down menu to choose the desired port direction. TCL

command is shown in Design View (Figure 2.75).

c. Port width can only be modified if it is already multi-bit. An error message is prompted out or shown in TCL
Console, if the input value does not meet rules (Figure 2.75).

. Propel Builder [C:
Fie Edt View Design Took Window Help
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/HelloWorld1.sbx] Device: LFC

[tV S

=)

Schematc

Baard: C

aaaa

Address &, start Page

= i instances
v+ I ahbi_jnst
+ 11 ahbi2apbO_inst
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7 Catoiog view |
-

el Con

v

v sbp_desion open -name HelloWorlal -path (C:/Users/izneng/HelloWorll/HelloWorlal/HelloWorldl.sbx)
% sbp_medify porc -neme ¥elloWorldl/rstn i —direction outpur

Figure 2.75. Port Direction

d. TCL history can be viewed in TCL History window (Figure 2.77) by choosing Design > TCL History (Figure 2.76).

%, Propel Buikder [D/desktop/wspace_festiriscvd/rscd/visevd shs] Device LFCPNO- 100-9LFGSTC Boaret CestusPro-NX Evaluation
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Figure 2.76. Open TCL History
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& Tel Histo X

sbp_create_project -name {my_soc} -path {D:Yscclworkspace \Example} -device {LFD2NX-40-88G256C} -speed {8_High-Performance_1.0} -board {Certus-iX Versa Evaluation(A)} Hanguage Verilog -psc {D:/lscc/propel{2024, 1ftemplates/MachiX03D_Template01/MachX03D_Template01.psc}
sbp_design dose

sbp_design open -name my_soc path {D: lscc/workspace/Example fmy_soc/my_soc/my_soc.sbi}

sbp_design dose

sbp_design open -name riscv2_v -path {D:/desktop/wspace_testr _v.shx}

sbp_design dose

sbp_design open -name riscv2 path {0 ._test/riscv 2 by

Figure 2.77. TCL History Window

e. PortBus MSB, LSB and direction can be modified. Click on PortBus and then use the drop-down menu to
choose the desired direction (Figure 2.78).

Note: If the input value does not meet rules, an error message prompts out or shows the in TCL Console.

. Propel Buider [C/Users/jzheng/HelloWorld HelloWorid |/ HelloWorld sbe] Device: LFCPNX-100-GLFGET2C. Baarch CertusPra-NiX Evalustion(A) - & x
Bl Et Wew Design Tooks Window Help

= I A BAE NS EH QQaQaQ
Lo o Shematc  Acdess % surtrage

LFCPNOL-100-9LFGST2C
~ 11 HelloWorld!
Instances
» T ahbi0inst
» ahbl2apb0_inst

41 /HelloWoridi . sbx)

Figure 2.78. PortBus Direction

2.2.8. Adjusting Address Spaces

The Address view shows the base address, size of the address segment, and the end address for each leaf
memory-mapped subordinate connection in the Propel Builder project. Propel Builder can automatically assign address
values, while the base address value can be changed manually. The addresses are automatically assigned when major
and subordinate components were connected. The ranges are set when the modules are configured. The end
addresses are calculated.

The Lock option on each address space prevents Auto Assign from changing the base address value. The Lock option is
selected automatically when you manually change the address value. To reset the address space, clear the Lock option
before clicking the Auto Assign icon.

Note: There is no Lock option on LocalMemory. The value of the base address can always be changed, while Auto
Assign does not reset it to its original value.

1. Inthe Propel Builder main window, click the Address tab. The Address view (Figure 2.79) shows.
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Schematic Address . Start Page
Cell Base Address Range End Address | Lock
~ cpul_inst 0x00000000
~ LocalMemory
cpul_inst/pic_timer_registers 0xFFFFO000 2K O0xFFFFOTFF

* cpulinst/AHBL_MO_INSTR(32 address bits: 4G)

sysmem{_inst/AHBL_S0 0x00000000 32K 0x00007FFF
* cpul_inst/AHBL_M1_DATA(32 address bits: 4G) 00000 7TFFF
0x00003000

gpiol_inst/APB_SO 0x00008400 1K 0x000087FF

sysmem{_inst/AHBL_S1 0x00000000 32K 0x00007FFF
uart0_inst/APB_SO 0x00008000 1K 0x000083FF 0x000083FF

0x00008400

gpio0_instfAPB_S0

0x000087FF

4 *

Figure 2.79. Address View

(Optional) Set or clear the Lock options as desired in Address view.
(Optional) Double-click the base address in Address view (Figure 2.80). Type the new value and press Enter.

Note: Values must align with 1K boundaries, such as 0x00000400, 0x00000800, or 0x00000C00. The end address
value changes based on the new value. The Lock option is selected automatically at this time.

Schematic Address Sy, Start Page
Cell Base Address Range End Address | Lock
~ cpul)_inst
™ LocalMemory OxFFFFO000
«cpul_inst/pic_timer_registers |[LI55550000 2K 0xFFFFOTFF

 cpul_inst/AHBL_MO_INSTR(32 address bits: 4G)

sysmem{_inst/AHBL_S0 000000000 32K 0x00007FFF
¥ cpul_inst/AHBL_M1_DATA(32 address bits: 4G)
gpio0_inst/APB_S0O 000008400 1K 0x000087FF
sysmem{_inst/AHBL_S1 000000000 32K 0x00007FFF
uart0_inst/APB_S0 0x00008000 1K 0x%000083FF
OxFFFFOTFF
Fl 3

Figure 2.80. Edit Base Address

Note: If there is a conflict of a related address space, it is shown in red in the graphic.

2.2.9. Validating the Design

The design rule check (DRC) can be run at any time. It can check if there is any illegal connection or overlapping address
space.

To perform the design rule check:Click the Validate Design icon @ on the toolbar of the Propel Builder main
window. The DRC results appear in the TCL Console.

Note: Optional bus ports handling

Optional input ports on Propel IP bus interface, such as AXI4 Stream, are left dangling when the driver side connected
bus do not support these ports. This may be IP dependent if the dangling input signals affect the functionality.
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Figure 2.81. Optional Bus Ports Handling

The default values of these ports are defined in abstraction Definition of AMBA Bus. Builder can detect the dangling
ports and then tie the default values to them. (Figure 2.81)

2.2.10. Generating the Propel Design

To create a Propel Builder module is to generate a .sbx file, which defines a Propel Builder project, RTL files, and the
instantiation templates. The instantiation templates have Verilog and VHDL code to help instantiate the Propel Builder
module in a design.

To generate Propel design:

From the toolbar of the Propel Builder main window, click the Generate icon 1 . This saves the Propel Builder
design and runs the design rules check (DRC) and can generate some RTL files. The RTL files include a top RTL file that is
the top module for the entire Propel design. The RTL files for IPs are regenerated when you click this button. If any
change is made on an IP, you need to use this icon to finish updating that IP.
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2.2.11. Generating the Memory Report

From the toolbar of the Propel Builder main window, click the Generate Memory Report icon ® . The SoC design
memory information is generated. The memory report folder (mem_report) is generated. All design memory
information is shown in detail in the memory report files. The Memory Report files are in HTML format (Figure 2.82). To
see more about address space, refer to the Adjusting Address Spaces section.

S0C Memory Map for SOC Project Summary Page
HelloWorldl Ganerated by Lattice Propel Softwars SOC Verification Engine

Copyright (C) 1992-2023 Lattice Semiconductor Corporation. All Rights Reserved.
Table of Contents

Project Summary

[ Project Name | Family [ Device | PartName | Speed [ Tanguage |

Figure 2.82. Memory Report

Click on the links in the left side pane, you can see more information on Detailed Memory Map (Figure 2.83) and each
of the instances (Figure 2.84).

SOC Memory Map for SOC : Detailed Memory Map Summary Page
HelloWorldl Generated by Lattice Propel Software SOC Verification Engine

Copyright (C) 1992-2023 Lattice Semiconductor Corporation. All Rights Reserved.
Table of Contents

Instance Summary
Instance Name

Description

Figure 2.83. Memory Report
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S0C Memory Map for SOC : Details for Instance - cpul inst
HelloWorldl Generated by Lattice Propsl Software SOC Verification Engine
Copyright (€) 1992-2023 Lattics Semiconductor Corporation. All Rights Reserved.
Table of Contents
cpul_inst Overview
Register
Start Addr End Addr Actual Range Width Description
0xFFFF0000 0xFFFFOTFF 32
cpul inst Register Summary
Offset Register Name Access Reset Value Width Description
3 o B
o B
o" 2
R B
o EB
G EB
o ER
R EB Timer Compare Highe
Field Summary for Register
[ Bit Field Name | Access [ Reset Value | Description |
[r1:0] |status |"=an |o |Interrupt status |
Ficld Summary for Register
[ Bit | Field Name | Access  [Reset Value | Description |
[t1:0] |enznie |"zmn |2 |Incerrupt Znanle |
Fisld Summary for Registsr
[ Bit | Field Name [ Access [ Reset value | Description |
[f1:01 |sec |rwor & |Tncerrupe Sec |
Fisld Summary for Registsr
[ Bit | Field Name | Access  [Reset value | Description |
[r1:01 | |r=ar o |Tnterrupe Polarity |
Field Summary for Register
Bit Fisld Name Access Reset Valus Description
,,,,, € N R bits of 64-bit timer
31:0 cnt_1 "RW" a
- - — register
Field Summary for Register
Bit Fisld Name Access Resst Valus Description
,,,,, N R bits of G4-bit timer
[31:0] cnt_h "R ] :
— sgister
Fisld Summary for Registsr
Bit Field Name Access Reset Value Description
..... R N R Lowsr 32 bits of 64-bit timer
[31:0] cmp_1 R 0 :
— compare register

Figure 2.84. Memory Report of Each Instance

2.2.12. Launch Project in Diamond or Radiant Software

In a complete SoC project, a Diamond or Radiant project can be created upon a Propel Builder design. After that, the
SoC project can be launched in Diamond or Radiant software.

According to the device in the SoC project, Propel Builder can launch Diamond or Radiant software accordingly.

v
For Diamond support device, the Diamond software icon shows in the Builder GUI Toolbar.

For Radiant support device, the Radiant software icon shows in the Builder GUI Toolbar.
Notes:

e Different device families are supported and available in Radiant/Diamond software, as shown in Table 2.1.

Table 2.1. Different Device Families Supported in Radiant or Diamond

Software Project Name Part Number
Radiant CertusPro-NX LFCPNX
Certus-NX LFD2NX
MachX05-NX LFMXO5
CrossLink-NX LIFCL
LAV-AT Evaluation LAV-AT
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Software Project Name Part Number
Diamond MachX02 LCMX02

MachX03D

LCMX03D

MachX03L

LCMXO03DL

MachXO3LF

LCMXO3DLF

Mach-NX

LFMNX

e The installation path of Diamond or Radiant should be set using Tools > Options > Directories. See Tools Options
section for more details. Or, Diamond or Radiant software cannot be invoked.

2.2.12.1. Launch Diamond Software

v
1. Click the Diamond icon

from the Propel Builder toolbar. Diamond software is launched.

A diamond_setup_template.tcl is generated in project path when you click the icon and is automatically invoked in
Diamond. Refer to the Lattice Diamond Help for the meaning and usage of the TCL commands.

In the meantime, there are also some files exported in project path, such as all RTL from IP, as well as the top-level

module.

IP encryption is converted to blowfish when exported to Diamond software. There are two sets of files generated
for each IP for Diamond. You can use the blowfish file in case you need to add it again later.

2. Lattice Diamond is launched with a Diamond project generated for SoC at the background (Figure 2.85).
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Sentry/lib/latticesemi.com/module/apb0/1.1.0/tl/apblx
. P P
Synthesis Constraint Files

Software Update Center
Currently running Lattice Diamand saftw

v LPF Constraint Files 3.12.1.399
[ Sentrylpf No updates available
Debug Files Last check time: Tue Oct 12 16:35:53 20|
Script Files
Analysis Files

Programming Files

Release Notes
Lattice Diameond Software 3.12 SP1 Release Notes

FPGA Design Guide
Design Planning
HDL Coding Guidelines

Timing Closure

User Guides

Lattice Diamond 3.12 User Guide

Lattice Synthesis Engine for Diamond User Guide  Other Tool Guides
Lattice Diamond 3.12 Platform Designer User Guide  ModelSim Users Manual
Clarity Designer User Guide Modelsim GUI Reference Manual
Lattice Diamond 3.12 Programming Tools User Guid ModelSim Command Reference Manual
Reveal User Guide ModelSim Tutorial
Reveal Troubleshooting Guide Synplify Pro User Guide
Lattice Diamond 3.12 Installation Guide for Windows Synplify Pro Reference Manual

Lattice Diamond 3.12 Installation Guide for Linux  Synplify Pro Language Support Reference Manual

Reference Guides TelfTk
Diamend 3.12 FPGA Libraries (HTML version)
Diamend 3.12 FPGA Libraries (PDF version)

Lattice on the Web
Lattice Semiconductor
Help Answer Database
Lattice Diamond 3.12 Help (HTML version)

Lattice Diameond 3.12 Help (PDF Version)

Lattice Solutions
Intellectual Property
Tutorials

Lattice Diamond 3.12 Tutorial

Lattice Synthesis Engine Tutorial

< > < >
Flelist Process  Hierarchy
TdCons.. & X Output & x
> source "C:||Starting: "scurce "C:/lscc/propel/2.l/workspace/Sentry/diamond setup template.tcl™
>

Starting: parse design source files

(VERI-1482) Analyzing Verilog file 'C:/lscc/diamond/3.12/ispfpga/userware/NT/S¥NTHESIS_HEADERS/machxo3d.v'

Done: design load finished with (0} errors, and (0) warnings

Starting: parse design source files

(VERI-1482) Analyzing Verileg file 'C:/lscc/diamond/3.12/1ispfpga/userware/NI/SYNTHESIS HEADERS/machzo3d.v'

FRT=142 1 1 £il il 1 1 T. il hd
< >| ouput Emor  Waming®  Info¥
Ready Mem Usage: 170,660 K

Figure 2.85. Diamond Project

3. (Optional) From the File List view of Diamond:

e  Modify the top-level RTL file (<proj_name>_Top.v) to match the SoC design, presupposition of which is that

there is a top-level RTL file in your SoC design.
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e Create a top-level RTL file (<proj_name>_Top.v) to match the SoC design, if the SoC design is created from an
Empty Project template and there is no top-level RTL file in your SoC design.

a. (Optional) Modify LPF constraint file (<proj_name>.lpf) to match the SoC design, if you have modified the
SoC design. This step is a must to the SoC design that is created from Empty Project template.

b. Switch to Process view of the Diamond project (Figure 2.86). Make sure at least one programming file
(bitstream File or JEDEC file) is selected in the Export Files section. Available programming files can be
different upon specific device included.
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Lattice Synthesis Engine Tutorial
< >
Flelist  Process  Hierarchy—Post Map Resources
TdCons.. & X Output 8 x
» source "c:||Initialized UFM Pages: 0 Page.
> pri_run E:
S Jedsc File [0]: Sentry impll.fea
Jedec File [1]: Sentry_impll a.jed
Total CPU Time: 2 secs
Total REAL Time: 2 secs
Peak Memory Usage: 211 MB
Done: completed successfully
v
< >| Output Emor  Warning®  Info®
Ready Mem Usage: 194,752 K

Figure 2.86. Generate Programming Files

c. Right-click Export Files and choose Run . The programming file is generated. The programming file
can be used in the Diamond Programmer.

Notes: Refer to the Lattice Diamond Help for more details of the Diamond project. Re-launch the Diamond project,
if the project settings are modified in Propel 2024.1 Builder.

If there is encrypted RTL in diamond project, it is automatically detected in Diamond.

Board template may have some constraint files. Constraint files are different per each type of the board. The constraint
files are also exported to Diamond.

2.2.12.2. Launch Radiant Software

1. Click the Radiant icon from the Propel Builder toolbar. Radiant software is launched.

A radiant_setup_template.tcl is generated in project path when you click this icon and is automatically invoked in
Radiant. Refer to the Lattice Radiant Help for meaning and usage of the TCL commands.

In the meantime, there will also be some file exported in project path, like all RTL from IP, as well as the top-level
module, and all files are listed in flist_design.f.

2. Lattice Radiant is launched with a Radiant project generated for SoC at the background (Figure 2.87).
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HelloWorld Project Summary

Resource Usage

Figure 2.87. Radiant Project

a. (Optional) From the File List view of Radiant:
e modify the top-level RTL file (<proj_name>_Top.v) to match the SoC design, presupposition of which is
that there is a top-level RTL file in your SoC design; or
e create a top-level RTL file (<proj_name>_Top.v) to match the SoC design, if the SoC design is created from
an Empty Project template and there is no top-level RTL file in your SoC design.
b. (Optional) Modify pdc constraint file (<proj_name>.pdc) to match the SoC design, if you have modified the SoC
design. This step is a must to the SoC design that is created from Empty Project template.

c. Click Run all. The Programming file is generated. It can be used in the Radiant Programmer.
Notes:
e Refer to the Lattice Radiant Help for more details of the Radiant project.

e Board template may have some constraint files. Constraint files are different per each type of board. The
constraint files are also exported to Radiant.

2.2.12.3. Ipx Based Implementation Flow in Radiant

To enable Radiant constraint propagation flow, the design source files need to be switched from original HDL files to
the .ipx file when generating the Radiant project.

Ipx based Radiant implementation flow is for project created in later than Propel Builder 2024.1. For project created
before Propel Builder 2024.1, use a different method for exporting files (Figure 2.88). If you want to use ipx flow in
these old projects, open them in Propel Builder 2024.1 and regenerate, then export to Radiant to change how it is
exported to Radiant. (Figure 2.89).

Considering some IPs are available at both Propel and Radiant side, you should only update IP through ipx in Propel
Builder side.

Note: You must avoid IP update (through ipx) in Radiant side. The potential out-of-sync of updating IP in Radiant side
may cause unexpected issues.
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Figure 2.89. Radiant Project for Project Since Propel Builder 2024.1
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2.2.13. Launching SDK and Generate Mem File

After a SoC design is completed, Propel SDK can be launched in Propel Builder GUI for further software development in
C project. For information about Propel SDK, refer to Lattice Propel 2024.1 SDK User Guide (FPGA-UG-02211).

Here is an example on how to generate a C project memory in Propel SDK for simulation use in verification project of
Propel Builder. See Generating Simulation Environment section for more details on simulation.

For a template SoC project, you can launch SDK directly by clicking Run Propel icon from Propel Builder toolbar if a
template SoC project is created.

1. Click the Run Propel icon “~ from Propel Builder GUI Toolbar. Lattice Propel Launcher (Figure 2.90) opens.

S Lattice Propel Launcher *

Select a directory as workspace

Lattice Propel uses the workspace directory to store its preferences and development artifacts.

T mn
Workspace: | .. Sworkspace w Browse...

[] Use this as the default and do not ask again
» Recent Workspaces

Figure 2.90. Lattice Propel Launcher Wizard

2. Click Launch. Propel SDK GUI opens. This C Project wizard is for loading the system and the board support package
(BSP) to create a C/C++ project (Figure 2.91).

Enter project name in the Project Name field, and then Click Next.
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9} C/C++ Project

Load System and BSP

Load lattice systern envirenment file and BSP package

Select system environment file and BSP package
System env: | Di/lscc/workspace/Example/Example/Exampled/../sge/sys_env.xml ~ Browse...

Select processor core to create C/C++ Project

Core selected: | cpul_inst

Project type: | C

System information

Device Famnily CPU Mame Instance Mame

LFCPMX riscv_mc cpul_inst

Select Example Application

Hello World Project Example-HelloWorld-blink-uart L]

1.Led blink
The corresponding 5oC project should include gpio instance.

2.Uart print
There art tow ways to support uart print:
a) The corresponding 50C project should include uart instance or local uart,
hi Frnahle SemihnctinnlSuctemn |ikrard! wihen creatinn thic nrniect ~

Project name: | riscv_mec_helloworld

Use default location

Location: | Divlsec\propelh2024.vwerkspace\riscv_mec_hellowerld Browse...

Choose file systern: fdefault

[]Build the project
Create a debug launch configuration for  OpenOCD

@ < Back Einish Cancel

Figure 2.91. Propel SDK GUI and C/C++ Project Wizard

3. Click Next. The C/C++ project dialog (Figure 2.92) opens.
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5 C/C++ Project

Lattice Toolchain Setting

Configuration: | Debug

Lib Setting  C/C++ Compiler C/C++ Linker

O No default libraries (-nodefaultlibs)
O Newlib

O Mewlib-nano (-—specs=nano.specs)
@® Picolib (--specs=picolibe.specs)

Printf Level
@ Integer only printf (-DPICOLIBC_INTEGER_PRINTF_SCANF)

(O Float printf (-DPICOLIBC_FLOAT_PRINTF_SCANF)
(O Full printf (-DPICOLIBC_DOUBLE_PRINTF_SCANF)

System Library
@® Default

O Semihosting (—oslib=semihost)
) Dummyhosting (--oslib=dummyhost]

@ ......... ey

Figure 2.92. Create C/C++ Project

4. Click Finish. The C/C++ project is created and is displayed using the C/C++ perspective. A perspective is a collection
of tool views for a particular purpose. The C/C++ perspective is for creating C/C++ programs.

5. Generate mem file in Propel SDK for simulation use:

To use simulation, first we need to generate the initialization file of System Memory instance (mem file) in Propel

SDK for simulation program to run on in verification project of Propel Builder.

6. In Propel SDK, right click on Project and then click Build Project (Figure 2.106). A mem file is generated in Debug

folder (Figure 2.94).
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Figure 2.93. Build C/C++ Project
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Figure 2.94. Mem File for Simulation
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Right click on the mem file and choose Show in > System Explorer to get this file (Figure 2.95).
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Figure 2.95. Mem File Location

7. Initialize memory for simulation:
After generating mem file in Propel SDK, you need to initialize memory for System Memory IP in Propel Builder.

In Propel Builder schematic view, double-click on system memory IP to open Module/IP Block Wizard. Click on
‘none’ in the Initialization File area and then click on “...” to select mem file from project (Figure 2.96).

xS @Ae s SHCMOMONONN |
~ Schemanc Address S StrtFage
| & Module/IP Block Wizard %
o v 220
21 o g et e o oot
O syt Contpre® o=
< General Port 50 Setings FPort 51 Setongs +
Propenty Velue
E—— —J——
sysmemO mmm 11-106496] e j acbo v pon e
o Data Bus Widthis) — F'
= —[HFpHBL_s0 — T 3 @‘T e SO
o O—————— ECC Enable T | =t
| —[#AHBL st .

T

ahbl_hclk_i
ahbl_hresetn_i

x port *PADDR' if
for port 'PADOR* i

and inte:

2 Po; PO AP = P APB_SO
% sbp design poe sge -2 (D:/lscc/workspece/Exemple/Exsmplel/Exsmplel/Exsmplel.sbx) -o (Di/lscc/werkspece/Example/Examplel/Exsmple2/ ./}

Figure 2.96. Initialize Memory for System Memory Module (1)

After the mem file is selected, check Initialize Memory (Figure 2.97).
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Diagram sysmem1 Configure IP
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Interface AHEL
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Memeory Type EBR
— +AH BL_SO Port Count 2
ECC Enable

— +AH BL_S]_ Enable Arbiter
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- - Initialize Memaory E
System memory Initialization File Format hex
- Initialization File CrossLinkMX Eva RX R¥Demo c.mem |
4 2 i Mo DRC issues are found.

Generate Cancel

Figure 2.97. Initialize Memory for System Memory Module (2)

For a SoC design, if the initialization file of System Memory instance (mem file) is built again in C project, system
memory instance should always be re-configured by double clicking on it in GUI .

Or, use the ECO flow to update the information.

ECO Editor in Radiant enables you to safely make changes to an implemented design without having to rerun the entire
process flow. ECOs are requests for small changes to be made to your design after it has been placed and routed.
Choose Tools > ECO Editor or click the ECO Editor button on the toolbar to open the ECO Editor. Choose the right
memory component and upload the memory file (Figure 2.98).

Refer to the Lattice Diamond Help/Lattice Radiant Help for more info on how to use an ECO flow.
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Figure 2.98. ECO flow in Radiant

2.2.14.1. Modifying the Project Settings

Propel 2024.1 Builder supports changing the projects settings. You can modify the device, package, speed and
operating conditions by double clicking the device part number from the Design View.

1. Double click the device part number from the Design View (Figure 2.99), the Modify Device Info wizard pops up

(Figure 2.100).
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Figure 2.99. Design View of Device Part Number

2. Use the drop-down menu to choose the desired device in Device filed in the Modify Device Info wizard
(Figure 2.100). Use the drop-down menu to change the package, speed and operating condition in Package, Speed,

Operating Condition filed.
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Dils:

PCSs:
Alls:
DiPHYS:

PIO Cells:
PIO Pins:

Figure 2.100. Modify Device Info

3. Click OK. The System Builder dialog (Figure 2.101) pops up showing a message of configuring all IPs.

W

Iﬂ_‘

et

This cperation needs to configure all [Ps in the current project.

Do you want to do this?

Yes

Mo

Figure 2.101. System Builder Dialog

4. Click Yes. By clicking Yes, the Builder engine regenerates each IP in the project with the updated device settings. All
IPs in current project are configured. The new device part number shows in Design View (Figure 2.102).
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Design View m]
a LFCPMNX-100-TCBG236!
+ 1 Helloworld
- 1? Instances
3 ﬂ equation_modulel_inst
v 1F ahbl0_inst
» 1 ahbl2apb0_inst
3 ﬂ apb{_inst
3 ﬂ cpul_inst
v 1 gpioD_inst
3 ﬂ oscl_inst
v 1E plioinst
3 ﬂ sysmem{_inst
3 ﬂ uartl_inst
3 Z Ports
» ,rE Mets
» Components

Properties
Mame: | uartl_inst

Type: Instance
Path: HelloWorld juartd_inst
WLNV:  latticesemi.com:ip:uartD: 1.3.0

IP Catalog Design View

Figure 2.102. Design View of Device Part Number

2.2.14.2. Undo/Redo

Propel 2024.1 Builder supports one-level undo/redo. You can click the Undo icon from the Propel Builder Toolbar to go

back to last action. Click the Redo icon from the Propel Builder Toolbar to recover last undo action.

e Undo: Choose Edit > Undo from the Lattice Propel Builder Menu bar. Or, click the Undo icon from
Propel Builder GUI Toolbar.

e Redo: Choose Edit > @
Propel Builder Toolbar.

Redo from the Lattice Propel Builder Menu bar. Or, click the Redo icon from

Note: Currently, Propel 2024.1 Builder only supports single-time undo/redo.
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2.2.14.3. Tools Options

Choose Tools > Options from Propel Builder menu bar. The Options Dialog opens (Figure 2.103).

e Themes

You can choose Light/Dark theme from pull-down menu.

Note: A restart of Propel Builder is required to take effect of the theme change (Figure 2.103).

4. Options

Themes:

Dark

X

Note: Theme changes after Propel Builder being restarted.

General

IP Tool

1P Install Path:

Color

C:/Users/xjin/PropelIPLocal

IP Public Path

Y:\sw_xjin\ip_install

IP Rtl Library Path

D:/temp

Templates

Templates Install Path:

C:/Users/xjin/propeltemplate

Radiant Location

C:/lscc/radiant/2022.1

Diamond Location

C:/lscc/diamond/3.13

Questasim Location

D:\install\questasim64_10.6b

OK

Network Settings

Directories

Move IPs to new location

Move templates to new location

Set Default

Cancel Apply

e  General (Figure 2.104)

Figure 2.103. Theme Change

You can use the right mouse button for zooming actions. See the Methods to Zoom section for more details.

The “Automatically connect after instantiating an instance” option is shown in this Options dialog. Click Apply to make

this function take effect.
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%, Options >
Themes: Light -
General Color Metwork Settings Directories

Use right mouse button for zooming actions

Automatically connect after instantiating an instance.

Set Default

oK Cancel Apply

Figure 2.104. General Options

When this auto-connect function is enabled, when an instance is instantiated (see Generating and Instantiating
IP/Module section for instantiate an IP), after clicking OK in Define Instance dialog (Figure 2.105), an addition dialog
box pops up with some suggested Clock/Reset connection for the ports on this IP (Figure 2.106). Check/Uncheck to
make the desired connections.

For functional use, refer to Connect Pins by Auto Connect for more details.
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4. Define Instance >

Instance Name: test222_inst
Instance Reference: test222:1.0.0
OK Cancel

Figure 2.105. Define Instance Dialog

., Connect Ports *

Driver Destination
Clock/Reset Connection
cli_i B dddd_inst/clk_i
cpul_inst/system_resetn_o dddd_inst/rstr_i

rstn_i

oK Cancel

Figure 2.106. Connect Ports Dialog

e  Color (Figure 2.107)

User can customize color for elements in Propel Builder, such as: the color of Error/Warning/Info Message, schematic
background, highlight.
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o,
Themes: Light
General Colar Metwork Settings Directories
MName Color
Highlight - 102, 102, 255
Caommeon Instance Fill I:I 255, 255, 255
Hier Instance Fill I:I 208, 214, 221
Bus Instance Fill |:| 144, 215, 236
Instance Text - 000
Instance Border - 0,00
Pin | ERE
Port Fill I:I 255, 255, 255
Port Text oo
Port Border | ERE
Interface Port Fill I:I 255, 255, 255
Interface Port Border - 0,00
Net | EXE
Interface Net oo
Schernatic background I:I 255, 255, 255
Selection [ 253,90, 90
Tel Command oo s
Info Message - 0,0, 255
Error Message - 255,00
Warning Message - 240,130,0
04
Figure 2.107. Color

Cancel

Set Default

Apply
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e Network Settings (Figure 2.108)

If you need to use a proxy server, click this Network Settings tab. Make the appropriate selections on this tab.

W Options >
Themes: Light -
General Color MNetwork Settings Directories

Use a Proxy Server
Host: Fort:

@ Sock5 HTTP Hitp Caching Ftp Caching

Set Default

OK Cancel Apply

Figure 2.108. Network Settings
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e Directories (Figure 2.109)

On this Directories tab, there are path setting for related tool.

%. Options X

Themes: Dark b

Note: Theme changes after Propel Builder being restarted.

General Color Network Settings Directories
IP Tool
IP Install Path: Move IPs to new location

C:/Users/xjin/PropelIPLocal
IP Public Path
Y:\sw_xjin\ip_install
IP Rtl Library Path

D:/temp

Templates
Templates Install Path: Move templates to new location

C:/Users/xjin/propeltemplate
Radiant Location

C:/Iscc/radiant/2022.1
Diamond Location
C:/lscc/diamond/3.13
Questasim Location

D:\install\questasimé4_10.6b

Set Default

oK Cancel Apply

Figure 2.109. Directories
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IP Tool (Figure 2.109):

e |P Installed Path (Figure 2.109): Folders of the IPs that are downloaded and installed. Refer to the Generating and

Instantiating IP/Module section for more details.
e |P Public Path (Figure 2.110):

4. Options

Themes:

General Color

IP TOOL
IP Install Path:

C: Usersfuser PropellPLocal
IP Public Path

C: Usersfuser /PropelIPPublic
IF RA Library

C: Usersfuser Rt

Templates
Templates Install Path:

C: Usersfuser PropeTemplateLocal
Radiant Location
C:/lsccfradiant/2023. 1

Diamond Location

C: lscc/diamond/3. 12

Questasim Location

C: JUsers user/AdditionalInstall

Metwork Settings

Light v

Directories

Move IPs to new location

Move templates to new location

Set Default

QK Cancel Apply

Figure 2.110. IP Public Path

IP Public Path is for administrator user to manage the public IP, and for general user to use the public IP.

Note: Make sure the path is accessible in your current system, without any additional transfer App installed.

e  For administrator user to manage the public IP:

e  The administrator user must have the write permission to this path.
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e If the administrator user wants to install or remove IP from the IP Public path, just set this as the same path in
the IP Install Path and then install/remove IP in IP catalog.

e  For general user to use Public IP:

e The general user must have the read permission of this path.

e Set the IP Public Path, and then refresh IP catalog to get IP from this path (Figure 2.111).
Note:

IP Public Path does not support network path in Windows Operation System (0S), for example,
\\192.168.11.11\shared\ip. Workaround for this is to map the Network Drive with the network path and set the path
with a local disk (Figure 2.112).

IP Catalog |
4
—
IF on Local IP on Server T-
L] Module/IP on Local
* Module
r Architecture_Modules
r Arithmetic_Modules
[ Mermory_Modules
r Processors_Controllers_and_Peripherals
[ Verification IP
P
™ Public [P
[ Connectivity
r Processors_Controllers_and_Peripherals
Figure 2.111. IP Catalog
X
v SThis PG
> 3ot Collapse @ Map Network Drive
> I Deskt Manage
> @ Docul Pin to Start What network folder would you like to map?
Map network drive...
>
5 ¥ :own Open in new window @ Specify the drive letter for the connection and the folder that you want to connect to:
1 om‘e Pin to Quick access
>. Musg Disconnect network drive... Drive: Z e
3items 1
‘ Add a network location \ Folder: s Browse...
Delete Example: \\server\share
Rename Reconnect at sign-in
: . —
Properties [Jconnect using different credentials
% Connect to a Web site that you can use to store your documents and pictures.

Finish Cancel

Figure 2.112. Map Network Device
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e [P RTL Library (Figure 2.109): Folders of the IP RTL library. Refer to Lattice Propel 2024.1 IP Package User Guide
(FPGA-UG-02213) for more details of the IP RTL Library.

Templates (Figure 2.109):

e Templates Install Path: Folders where the templates installed. See the Define Custom Template section for more
details.

e Radiant Location (Figure 2.109): Folder where Radiant software installed.
e Diamond Location (Figure 2.109): Folder where Diamond software installed.

e Questasim Location (Figure 2.109): Folder where Questasim software installed (see Launching Simulation
section for more information).

2.3. Verification Project Flow
2.3.1. Creating a Verification Project

1. Choose File > New Design from Lattice Propel Builder Menu Bar. The Create System Design wizard opens
(Figure 2.113).

% Create System Design x

Design Information
Enter a name for your design and spedfy a directory where the desian files will be stored.

Project:

Type: SoC Verification -

Mame: Verification_Project

Location: | C:flsccfworkspace * | | Browse...

Create Project at C:flsccfworkspace Merification_Project

Mext = Cancel

Figure 2.113. Create System Design — Design Information Wizard

Choose SoC Verification from the Type field.
Enter a project name in the Name field.

(Optional) Use the Browse option to change the project location in the Location field if needed.

vk W

Click Next. The Propel Project Configure wizard is shown as Figure 2.114.
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4, Create System Design

Configure Propel Project
Specify a device or board for project.

Language:

4

SystemVerilog

Template Info:

Template Categories: Device Information:
All Templates - | Parthumber:
Logic Cells:
Select 5oC Project: LUTs:
Registers:
EBR Blocks:
LR.AM:
DSP (18x18 Multiplier):
PLLs:
DlLs:
PCSs:
AlUs:
DPHYs:
PIO Cells:
PIO Pins:

space Example Example/Example.sbx | | Browse...

< Back

jd5r00-30-8CBG256C
39000

32258

32256

34

2

56

L= s e ]

202

Template Manager

Mext = Cancel

Figure 2.114. Create System Design — Propel Project Configure Wizard

6. (Optional) The default Hardware Description Language (HDL) is displayed in the Language area. Use the drop-down

menu to change the default language.

Select an existing SBX design by using Browse to choose an SBX file.

Click Next. The Project Information wizard opens.

Click Finish. The dut_inst of SoC project is shown in the Schematic view (Figure 2.115).
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. Propel Builder [C:/lscc/workspace/Verification_Project/Verification_Projectsbx] Device: LFCPNX-100-SLFGET2C Board: NA - O X
File Edit View Design Tools Window Help
= =5 -] oy

4 5 A BEE ; B ceaaa
Desynjiiea] = Schematic Address % StartPage

I LFCPNX-100-0LFG672C A
~ 1 Verification_Project

= i¥ Instances

» 1E dutinst
Companents
dut_inst
’-——.—.—.—.————.—.———\
—) rstn_i led_o h

Properties l .
Name: | dut_inst _l rxd_i txd_o ;
Type: Instance \ i
Path:  Verffication_Project/dut_inst v
VUNV: Inttice:systembuidersdut: 10 o e ——————

1P Catalog Design View a 1
Tel Console [u]
% sbp_design new -neme Verification Project -path {C:/lscc/workspace/Verification Project/Verification Project.sbx} -device {LECENX-100-SLEGE72C} -speed
{9_High-Performance 1.0V}
% sbp_add_sbxcomp -name dut -path {C:/1scc/workspace/HelloWorld/HelloWorld/HelloWorld. sbx}
+

Figure 2.115. Verification Project

Note: The default instance name of an imported Design Under Test (DUT) is dut_inst. By default, its boundary is shown

with dotted line, and the filled-in color is gray. If there is any change in the SOC design, the dut_inst DUT block can be

updated accordingly by double-clicking this dut_inst DUT block.

[,
10. Click the plus sign L=4 of this dut_inst DUT block. You can see the whole SoC Design (Figure 2.116). Click the

ryi

r=1

negative sign L—J to close the expanded bus.

cpu0_inst

e — o s s |
o sy oxTage P oot
i TIMER_IRQ_MOPFb= ahb_vesstn_i ,wu_»mf "fk,,m'a.
{ tni  system_resew of ahtl_hok_i i ]
L'__ I_hclk_i
L
ahbizapbo inst —gEe0 it

50 FFAPESh e
1l = H TREF
L | e arevo Lrronsoo - TR
’ F(:ﬁ_i g
!

? presen | J |_ uartd_inst
o APB_SD

T ki INT_MoF

23.2. S

Propel Builder also support switching from SoC project to verification project when a SoC project is already created.

Figure 2.116. Whole SoC Design

witching from SoC Design Project to Verification Project

1. Create a SoC design project. Refer to the previous Creating SoC Project section for more details on this .
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From design project window, click V/D button . A dialog box opens prompting you to save the changes, if the
current design project is not saved yet (Figure 2.117).
% Propel Builder [D:/lscc/workspace/Example/Example2/Example2/Example2.sbx] Device: LFCPNX-100-9LFG672C Board: CertusPro-NX Evaluation - [m] X

file Edit View Design Tools Window Help

o'iB f)'u é m@ 1IN
Design View m]
10 LFCPNX-100-9LFGE72C
= I Example2 &
= ¥ Instances
b 1F ahbl0_inst
» 1 shbl2apb0_inst
I¢ apb0_inst
T cpuliinst
7% equation_module0_inst
TF oscOlinst
I plioinst
IF sysmem0_inst
IF uart0_inst o Save changes made to Example2 before opening another system design?
IF gpiol_inst
» -7 Ports M Yes Mo Cancel
Properties

T aaaea w

Schematic Address . Start Page

& Propel Builder b

Ov v vvwowowor

MName:  gpio0_inst El=

Type: Instance
Path:  Example2/gpio0_inst
VLWV: [atticesemi.com:ip:gpiod: 1.6. 1

Design View IP Catalog q

Figure 2.117. SoC Design Project

Notes:
e SoC design project is called ***.sbx. Verification project is called ***_v.sbx (Figure 2.117).

e V/D button is used to switch between Verification project and SoC Design project. When you create a SoC
project, a related verification project is automatically created in the design project. This is how
Verification/Design switch works, because they are auto-linked during project creation. Check .soc project file
under the top project directory to see these details.

e  For some template SoC project, they may include a pre-developed functioning verification project.

Click Yes to save the current design project. The Propel Builder GUI switches to verification project (Figure 2.118).

“ Propel Buider pies [I ple2_v.sbic] | Devace: LECPNX-100-9LFGST2C Board NA - a x
e Edt View Desgn Took Wndow Hep
P . ~ o
ss@HA M FEExcEB QQQ N
2 Catslog D] et e s
Porloal  Ponseve v

I Moduie® on Loca

sysck_rst_gen1_inst uart_model1_inst

uart_rx_data_debug[7:0] p=

uart_tx_data_debug[7:0] jm=

clk uart_rx_break_debugl—
rstn uart_n_valid_debug— NP~ A — c
1
rt_rxd uart_tx_busy_debug|— ’E] :
bud_nll—
uart_tx_en_debugi— rstn_i I
led_o[7:0]j=m
vart_txd| «d_i :
______________________ 7]
i
i
1
i

Figure 2.118. Verification Project
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Note:

e Each time you switch from SoC design project to Verification project, remember to:

e If you want to go back and design more on SoC project, click V/D button
to go back to the SoC design project.(Figure 2.118)

a. Save SoC Design Project first.
b. Click on V/D button to switch to Verification project.

on the verification project window

c. Reload dut_inst to synchronize the SoC design change to verification project. Double click on dut_inst to do

the reload (Figure 2.119).

Y
File Edit View Design Tools Window Help
o - —
- B L& mMEERXEB QQQQ W |
Desnj/ien] L= Schematic Address 3\ Start Page
I LFCPNX-100-9LFG672C = e
~ 1% Example2.v & &
= {# Instances
v 1 dut inst
+ £F Instances
» 1 ahbloinst sysclk_rst_gen1_inst uart_model1_inst
b 1} ahbl2apb0_inst
b L1 apbl_inst dut_ck_o| uart_rx_data_debug[7:0]
1'b1] i
» 21 cpulinst dut_rst_i dut rst o uart_tx_data_debug[7:0]
» 1 equation_moduled_inst S
» T1 apiabimm dut_ch_i uart_rx_break_debug dut inst
b 1} oscD_inst | Reload sbx for instance dut_inst? uvart_rx_vald_debug| |T.._____::_ _______ -|
)
3 y
D i inst | uart_tx_busy_debug §+ ]
v I} sysmem0 inst Al | Yes No I ) txd_o—
Properties | uart_tx_en_debug ——rstn_i ]
! | led_o[7:0]te=
Name: | dut_inst { uart_txd —xd i l
! i
Type: Instance H
Path:  Example2_v/dut_inst i
VLNV: lattice:systembuilder:dut: 1.0 i
Design View IP Catalog 0 E
Tel Console u]
Finished: "sbp design close" |
pen -name Example2 v -path {D:/lscc/workspace/Example/Example2/verification/Example2 v.sbx}
— Port Bus width does not match for port 'PADDR' in interface 'apbO_inst.APB _MOO' and interface 'uartd_inst.APB_50"
- Port Bus width doss not match for port 'PADDR' in interface 'apb(_inst.APB MO1' and interface 'opic_inst.APB_S0'
s

Figure 2.119. Reload dut_inst after Each SoC Project Design Change

2.3.3. Opening a Verification Project

Refer to the Opening an Existing SoC Project section for procedure in detail.

2.3.4. Adding Modules, IP and VIPs

Refer to the Generating and Instantiating IP/Module section for procedure in detail.

2.3.5. Working with the Schematic View

Refer to the previous Working with the Schematic View section for procedure in detail.

2.3.6. Connecting Modules

Refer to the previous Connecting Modules section for procedure in detail.

2.3.7. Viewing Address Maps

The Address view shows the read-only address maps of the soc design (Figure 2.120).
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Schematic Address 4. Start Page
Cell Base Address Range End Address Lock
 cpul_inst

~ LocalMemory

cpu0_inst/pic_timer_registers [~ 0000 | 2K OXFEFFOTEF

= test_v/cpul0_inst/riscv_ahbl_m_instr_Address_Space(32 address bits: 4G)

sysmem0O_inst/AHBL_50 32K 0x00007FFF
= test_ v/cpu0_inst/riscv_ahbl_m_data_Address_Space(32 address bits: 4G)
gpio0_inst/APB_50 1K 0Ox000087FF
sysmem0O_inst/AHBL_51 32K 0x00007FFF
uart0_inst/APB_50 1K 0x000083FF

Figure 2.120. Address Maps

2.3.8. Monitoring DUT

This feature is available to Verification project only. In Propel Builder, the pin inside DUT can be connected to the input
pin of a VIP. The connected pins can be found at both ends of the orange line, as shown in Figure 2.121. Only pin and
pin bus are supported in the current release of Propel Builder.

3

g Ed

Figure 2.121. Monitoring DUT

The testbench generated for this Verification project is shown in Figure 2.122. This testbench file can be used for
simulation. For testbench generation, see Generating Simulation Environment.
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lk_r;t_g;nz_inst_dut_clk_i_net;

clk rst genl inst dut_clk i net = dut_inst.osc0_inst.hf clk out_o;

Figure 2.122. Testbench of the Verification Project

2.3.9. Generating Simulation Environment

1. (Optional) In design project view, initialize mem file in System Memory IP instance. See Launching SDK and
Generate Mem File section for how to generate mem file. If you want to launch simulation without the actual
program running, which is not a functioning simulation environment, you can skip this step.

. Module/IP Block Wizard H

[« C it from Module system_memory ion 2.1.0
Set the following parameters to configure this component.

Diagram sysmem1 Configure IP
General Port S0 Settings Port 51 Settings

Property Value
~ General

1 Interface AHEL

sysm em Memory Address Depth [1- 106496] 4192
r ™ Data Bus Width(bits) 32
Memory Type EER
— H BL_SO Port Count 2

ECC Enable

— H BL S1 Enable Arbiter

~ Data Streamer

—a h bl_hcl k_l Enable Data Streamer

—ahbl_hresetn_i

- |nitialization

b vy o
Initialize Memory =
system memory Initialization File Format hex
Initialization File |
-
4 ¥ | No DRC issues are found.

Generate Cancel

Figure 2.123. Initialization of Mem File
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In design project view, click V/D button to switch to verification project. Check the Switching from SoC Design
Project to Verification Project section for more notes on this operation.
The verification project is located at ./<project_name>/verification.

In verification project view, click Generate icon 2 in the Propel Builder Toolbar (Figure 2.124).

If prompted with ‘INFO: The simulation environment has been created’ in TCL counsel, then the testbench is
generated in: <project_name>/verification/sim.

Note:

inderwr Help

1P Catalog
~
<

1P enLocal

uart_modell_inst

sysclk_rst_geni_inst
—

dut_ck _o— uart_rx_data_debug[7:0] ==
URL e st dut_rst_o|— uart_tx_data_debug[7:0]m=
dut_ck_i th_ck of ck wart_rx_break_debug

uart_rx_valid_debug dut_inst

uart_tx_busy_debug
uart_tx_en_debug

e rst_«

uart_ted

Figure 2.124. Generate Simulation Environment on Verification Project

The testbench file structure is shown as below (Figure 2.125):

+--- [sim] -- Generated simulation environment folder
| +--- [hd1l_header]
| | +--- soc_regs.v -- Register definitions of all the components in DUT/SOC
| | +--- sys_platform.v -- Base address, user settings of all the components in DUT/SOC
| +--- [misc]
| | oo kU -- All the mem, hex, txt files will be copied here
| +--- flist.f -- File list for HDLs
| +--- flist_sim.f -- File list for all files used in simulation
| +--- gsim.do -- Do script for simulator,

gsim.do: QuestaSim. |

This file compiles project and invokes simulator with
| some default settings using the generated testbench.
| +--- wave.do -- Do script for adding signals in waveform window
| +--- <project_name>_v.sv -- Top testbench, it’s SystemVerilog based.

Figure 2.125. Testbench File Structure

If there is any change to the design project, make sure to save the design in design project view, switching from
design project to verification project using V/D button. Reload dut_inst and generate simulation in verification
project again. See Switching from SoC Design Project to Verification Project section for more details.

Unlike those HDLs generated in the SOC design project directory, the testbench generation in the Verification
project is just a start point for you to work with, not necessarily a full functioning verification project.

If there is a simulation tool change, make sure to generate simulation environment again. Otherwise, a dialog box
pops up prompting you to make a choice of Yes or No (Figure 2.126).
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4. Propel Builder *

Current simulator has been changed. This operation will overwrite the most
recent simulation result. Do you want to continue?

Yes Mo

Figure 2.126. Remind for Simulation Tool Change

2.3.10. Launching Simulation

1. After Generating Simulation Environment, simulation project is generated in <project_name>/verification/sim.

2

2. Click Launch Simulation icon in verification project view to launch simulation.

Note: SoC design project is called ***.sbx. Verification project is called ***_v.sbx (Figure 2.127).

—
@ Propel Buikder (D:/desktap/wipace test/questa | verficaborfquestat s s | Device: LFOZNX-0-B8G2562 Board: KA - o x
=] -'Qr_,»'E‘QQQQ.
Design View =] . Schemanc Acdress . Start Page
- 1 i
+ @ e
: :::;j:_"}'““ sysclk_rst_gen1_inst uart_modell_inst
+ [ it ( (
+ 0 eqtion mac dut_ck_o uart_rx_data_debug[7:0]—
+ 5 gt ,
s 0Lt rst o dut_rst_o— uart_tx_data_debug[7:0]—
- g
* B omenlan etk | th_ck i uart_rx_break_debug— |
- to_rst. tn uart_r_valid_debug|— [P dutnst
b e i ,E )
: B =y o s ey | '
- ! txd_of
f ' uart tx_en debugl— -t rsin i ]
b= ) ! led_o[7:0]—
Lo uart_txd rxd_i 1
. w :
Pt ot J } L J
VINY: latbicesend comip; cpull:24.0 !
owke  osgprem .
Figure 2.127. Launch Simulation in Verification Project
[ ouesrs Lamice OB £ - o x
Fhe it View Compi
BT L LT Y R || cometar hiiconmns =

e BT Y I e I T
x| etk
oo s -

Rl © < shtim s bozes s e oow e s i . [sho00on | roore

oo
[

Figure 2.128. Questa Simulation GUI
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3. Ifthereis no simulation tool specified in Tools > Options > Directories, the default built-in simulation tool, OEM

version of QuestaSim, opens (Figure 2.128). If specified, the specified simulation tool opens.

See Figure 2.129 for simulation file structure.

For OEM version QuestaSim, there are pre-compiled simulation libraries.

wispace_test » questal » werification » sim »

Marne

hd|_header
weork
[ bht_ini.bin
|:| compiledog
[ flistf
[ ] flist_sim.f
|:| rsirn.do
|J optimize.log

|:] gsirn.do

|J questal_waw
|:] reginit.bin
|J sim.log

|:] wsirnalf

|J wrave,do

e

v O
Date modified

32572024 220 AM
44272024 350 Ak
342572024 2:20 Ak
44272024 350 Ak
342572024 2:20 Ak
342572024 2:20 AkA
342572024 213 Ak
47272024 550 A
342572024 232 Ak
32572024 220 AM
342572024 2:20 AkA
47272024 550 A
4/2/2024 350 A
32572024 220 AM

20 Search sim

Type

File folder

File folder

BIM File

Text Document
F File

F File

Do File

Text Document
Do File

=W File

BIM File

Text Document
WLF File

D File

Size

5T KB
5 KB
2 KB
2 KB
1KE
19 KB
1KE
6 kB
2 KB
20KB
OKB
1KE

Figure 2.129. Testbench File Structure in Simulation Project

For non-OEM version simulation tool, the script under simulation project directory can detect whether or not
there are existing simulation libraries under the ovi_<device_family_name> folder. If yes, simulation uses the
existing library; otherwise, the device library can be created and compiled once into the ovi folder for further
use, and this compiling process may take some time.

© 2024 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice

FPGA-UG-02212-1.0

97


http://www.latticesemi.com/legal

mLATTICE

2.4. Advanced Usage

2.4.1. Supported Interface

Lattice Propel Builder and IP Packager share the same usage of interfaces. These interfaces are listed below.
e Interrupt

e AMBA3 AHB Lite

e AMBA3 APB

e AMBA4 AXI4

e AMBA4 AXI4 Lite

e  AMBA4 AXI4 Stream

e Localbus

Refer to Lattice IP Packager 2024.1 User Guide (FPGA-UG-02213) for detailed usage of these interfaces in the IP
Packager.

2.4.2. Supported Language

Propel 2024.1 Builder supports the following languages:

e Verilog HDL

e SystemVerilog

e VHDL

e  Mixed Verilog/VHDL

Currently, verification projects and RTL module (see RTL section) only support Verilog HDL.

2.4.3. Supported Hierarchical IP

Hierarchical IP instantiates a hierarchical component that contains a reference to a design along with a description of
the top-level interface of the component.

Click Expand IP sign on the left corner of the hierarchical IP (Figure 2.130) to show the detailed design scope of
this IP (Figure 2.131).

axilx3_inst
____________________ .
+ '
' I
I -_— -_—
= [mjmAXI_S00 AXIL_MO1 || b
L LY :
| _
ki AXT_MOO ||
| LE
' I
rstn_i AXI_MO2 || prmmm
|\ LX)

Figure 2.130. Hierarchical IP
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axiix3_inst

i R
: axi2axil_MO1_inst !
i f !
_ |
: {1 AXI_S00 I
| Lia :

| = | AXIL_MO1

I clk AXIL_MOO| =

i o0 i
|
| rst_n |
: |
|
| o |
I axi_crossbarNxM_inst |

: - ~N | AXI_MOO
AXI_S00 = o T
AXI_S00 AXI_MO1 |
; Hee vosf] |
. " - |
ck_il r=- reg_slice_M02_inst |
i ck AX]_MOOL-!-J - :
rstr_i| = = |
= ret_n AxLMoz[-H [-HAXLsoo 1
= = |
| |
: \ / clk |
l |
| rst_n :
: |
i S 1
: |
N e o o e e 2 /I

Figure 2.131. Hierarchical IP Scope in Detail

2.4.4. Export Interface

AHB Lite or APB interface ports can be connected to external IP outside of Propel Builder. You must use AHB-Lite or
APB feedthrough modules to hold the address space information when the feedthrough module is configured as major,
or to hold memory map information when the feedthrough module is configured as subordinate. The interface to be
exported should be connected first to feedthrough, then the other end of the feedthrough can be exported. An
example is shown in Figure 2.132.

apb_s0_inst

) FF APE_S0APE_MOFF apb_s0_inst_APB_M0_interface
apb_m0_inst apb_int_inst pb_s0_inst_APB_MOI
apb_m0_inst_APB_S0_interface [£ M—FAPB}M APE_MOGGE, apb_s1_inst

——FF APB_S00
'Fl " APB_MOIFF| FF APB_S0APB_MOFF =5 apb_s1_inst_APB_MO_interface
) pok i
_APE_MO2FF
) presetn i

apb_s2_inst

ahbl2apb _0_inst
FF APE_S0APE_MOH
e FF APE_S(APE_MOFF apb_s2_inst_APB_MO_interface
clk_i APE_MOFF|
tni

i

TIMER_IRQ_MOA
g g MERIRRLH r,; sys_mem_0_inst
AHEL_MO_INSTRRF 1
= ki o FF AHBL S0
- AHEL_M1_DATAFF
rst_n_i[_> i i FF AHBL 51
System_resetn_ ahbl_int_inst ahil_helk_i

F AHBL_S00 AHBL_MO1HF —d ahib_hresem_i .
C—fshbl_halk i  AHBL_MODFF| ahbl_s0_inst

I—alu_hm_i AHBL_MO2FF FF AHBL_SO AHBL,MBFF'—E>ahbl_sU_lnst_AHEL_MU_\nterfa\:e

Figure 2.132. Export Interface Example

In the example above, to export interface ahbl_int_inst. AHB_MO02:

1. Instantiate an AHB-Lite feedthrough module from IP catalog, and configure it as subordinate. The instance name
here is ahbl_sO_inst.

2. Set the address width and data width for the memory map.
3. Connect ahbl_int_inst. AHB_MO2 to ahbl_sO_inst.AHBL_SO.
4. Export ahbl_sO_inst. AHBL_MO for external IP.

You can see the memory map for ahbl_sO_inst is shown in the Address Editor (Figure 2.133).
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Schematic Address % Start Page
Cell Base Address Range End Address  Lock

v apb_mi{_inst

* apb_m0_inst/APBE_MO(32 address bits: 64K)

apb_s0_inst/APB_S0 0x00010800 1K 0x00010BFF [

apb_s1_inst/APB_S0 0x00010C00 1K 0x00010FFF [

apb_s2_inst/APB_S0 0x00011000 2K 0x000117FF [
* cpu_0_inst

T LocalMemory
cpu_0_inst/pic_timer_registers OxFFFFO000 2K OxFFFFOTFF

¥ cpu_0_inst/AHBL_MO_INSTR(32 address bits: 4G)

sys_mem_{_inst/AHBL_S0 0x00000000 64K 0x0000FFFF [
* cpu_0_inst/AHBL_M1_DATA(32 address bits: 4G)

ahbl_s0_inst/AHBL_S0 0x00010000 2K 0x000107FF [

apb_s0_inst/APB_S0 0x00010800 1K 0x00010BFF [

apb_s1_inst/APB_S0 0x00010C00 1K 0x00010FFF [

apb_s2_inst/APB_S0 0x00011000 2K 0x000117FF [

sys_mem_0_inst/AHBL_S1 0x00000000 64K 0x0000FFFF [

Figure 2.133. Memory Map for ahbl_s0_inst in Address Editor

2.4.5. Define Custom Template

Saving a design as a template is an enhancement feature of Propel Builder, which allows you to create your own new
project template based on an existing design. You can deploy this template into Propel Builder later or share it with
others by saving template into a .ptmp file. See the following on how to generate a .ptmp file.

Notes:

e The GUI entry of this function takes effect from Propel Builder 2022.1, so the design created in earlier Propel
Builder versions cannot define its custom template.

e Refer to Lattice Propel 2024.1 SDK User Guide (FPGA-UG-02211) for more details on how to use custom template
in Propel SDK.

You can access Template Manager in two ways:
e Access during project creation. See the Creating SoC Project for more information.

e Choose Tools > Template Manager from Propel Builder Menu Bar.

2.4.5.1. Export the Current Template Configuration
Choose Tools > Create Template from Propel Builder Menu Bar. Template Configuration (Figure 2.134) opens.
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4. Template Configuration X
General
Name: RISC-V MC Dual Processor Project_1 Processor: RISC-V MC
Vendor: Latticesemi [ RISC-V SM
(] RISC-V RX
Version: 1.0
Board Only: Description: | Tomplate description
Device Family: [] LAV-AT o
LFCPNX
[] LFD2NX
[] LFMX05
] LIFCL
] LFMNX
1 Machx0?2
[] MachX03D -
Supported Boards
Name Version Parthame Speed Constraint File
1 CertusPro-NX Evaluation A LFCPNX-100-9LFG672C 9_High-Performance_1.0V ./Example2.pdc

Add Remaove

Template Resources

1 [E /Example2/application

Share Template
D:flscc/my_workspace/Example2.ptmp

Generate | Cancel

Figure 2.134. Export Template Configuration Page

1. Fillin general information such as Template name, Description, Vendor.

2. Select Processor, Device Family, and Supported Boards.

The device used in the current design is listed by default. You must make sure the design can work on all the
devices in the list.

Click on an IP instance in Schematic view. The Design View shows the corresponding information of this IP.

Check VLNV for this IP name (Figure 2.135). Go to IP Catalog and click on C} before this IP to show the IP
Information. In the Device Supported area, all the devices this IP supports are listed (Figure 2.136). Make sure
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all the IP instances in the design have the device support which are listed in the Board Family list in Template
Configuration (Figure 2.134).

Desian View a Schematic nddress & Start Page
LFCPNX-100-9LFG672C -
* 1 Example2 &
= ¥ Instances
B ahbl0_inst
» 2% ahbl1_inst
+ 11 ahbl2apb0_inst
B ahbl2apb1_inst P
v 1F apb0_inst

cpul_inst sens

1 cpul_inst

+ 1} equation_moduleQ_inst .,-.-...:
+ 1 gpio_inst } o
+ £ osc inst i
' s
= scb
e =
) e -

sysmem0_inst

p——
, sysmem1_inst M
v @ —,
£ uartinst J o]
» 1 pli0_inst .
0
» 3 Ports
+ 5= Buslnterfaces
b Nets e L e
‘ e IR 50_rawtca(E> ey [ . o
+ [# Components e TN a5 Jomas e Tl wase IJ
gy nesei e
s
U fas
—pon
I
Frogerties
Wame: pllo_inst
Type: Instance
Fath:  Example2/plio_inst
VLKV: latticesami.com:module:pll0:1.8.0
P Catalog Design View N n e

Figure 2.135. Check IP Name in Design View

. Propel Builder p/wspace t sbx] Device: LFCPNX-100-9LFG672C Board: CertusPro-NX Evaluation(A) - X

File Edit View Design Tools Window Help

sERAOHYCTE MEGNOSHELIREG @QaQQ

P Catalog o Schematic Address A startpage
~ g a
o &
P onlocal  on Server T
[ Module/IP on Local -
~ Module
~ (7 Architecture Modules:
F 05C 140
@ ## pLL 170
7 Module: i Version: 1.7.0
Vendor: latticesemi.com | 130
& Subfractor 140
# Comparator 140
% Complex_Mult 150
F Convert 140
B Counter 140 -
B LFR 140 a0 et
B} Mult Accumulate 150 s im0 d
B Mult Add Sub 150 i staetn ot :
% Mult Add_Sub Sum 150 1 L
T Multiplier 140 1 r e
5 Sin_Cos_Table 130 L Py
5 Subtractor 140 I T | s
» Memory_Modules —— 9
» [ Processors Contrallers_and_Peripherals
» () Verification IP
- e |
-‘4¢ f= sus-E }nus T>o
l equation  split concatinvert
TP Catalog Design View a OB
1P Information =]
Description
The Lattice Semiconductor PLL IP implements a Phase Locked Loop
Devices Supported
LIFCL-40, LIFCL-33, LIFCL-17, LFD2NX-40, LFD2NX-17, LFCPNX-100, LFMX05-25, UT24C40, UT24CP100
References
Tdconsce P informaton

Figure 2.136. Check Device Supported in IP Information

e You can add the board information manually in Supported Boards (refer to Figure 2.5) for board information).
You must ensure the correctness of the board information and the design can work on this board.

e Board must contain a Constraint File. Double click on the constraint file name (./Example2.pdc), and then click
‘... button to select the constraint file (Figure 2.137).
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% Template Configuration X
General
Name: RISC-V MC Dual Processor Project_1 Processor: RISC-V MC
Vendor: Latticesemi [1RISC-V SM
] RISC-V RX

Version: 1.0
Board Only: Description: | remplate description
Device Family: [] LAV-AT -

LFCPNX

(] LFD2NX

] LFMXO05

] LIFCL

[ ] LFMMNX

1 Machx02

1 Marh¥N2n A

Supported Boards

Name Version PartName Speed Constraint File

1 CertusPro-NX Evaluation A LFCPMX-100-9LFG672C 9_High-Performance_1.0V | Bl=E =06 D

Add Remove

Template Resources

1 [ /Example2/application

Share Template

Generate | | Cancel

Figure 2.137. Double Click on the Constraint File Name

3. Template Resources:
Optional resources include the newly created project such as C application project, user RTLs.
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Output:

By default, after you click the Generate button, the new template can be installed to your custom template
folder, which is a folder named PropelTemplateLocal under SHOME (Figure 2.138).

Option under Template Resources, such as the application folder, contains functional-ready embedded
application source codes for C project. Check the box before it (Figure 2.134), then the application under
current project is also exported to destination (Figure 2.138). Other files under this option works the same

way.

| ™ + | Latticesemi_New_Hello_World_1_1.0

Home Share View

« v » ThisPC » Windows (C:) » Users » jzheng » PropelTemplatelocal » Latticesemi_New_Hello_World_1_1.0 v

MName Date modified Type Size

7 Quick access

application File folder
@ OneDrive lib File folder
I This PC werification File folder
300b || Mew_Hello_Waorld_1.psc PSC File 1KB
ects
- } || Mew_Hello_World_1.tcl TCL File SKB
I Desktop |=| New_Hello_World_1.txt Text Document 1KB

|5 Documents

Figure 2.138. Export Template to PropelTemplateLocal Folder

If you want to share this template, you can click Share Template and output this template to a .ptmp file
which can be later installed to Propel Builder by other people. You can export a template to share later using
template manager.

Template manager page for custom templates.

You can import/delete/export a selected template in Template Manager when creating a new system design
(Figure 2.139 and Figure 2.140).
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Configure Propel Project

Specify a device or board for project.

Language:

Verilog

Family:
LAV-AT
Device:
LAV-AT-500L
Package:
LFG1156
Speed:
1
Operating Condition:

Commercial

Template Info:

Board Processor:
- RISC-V MC
Templates:

~  Empty Project
Hello World Project

Empty project for user to "build from scratch”

Online Data Sheet for Device

Device Information:
Part Number: LAV-AT-500L-1LFG1156C

Logic Cells: 477000
LUTs: 397440
Registers: 397440
EER Blocks: 990
DDRPHY: B3]
DSPs: 1800
PLLs: 11
DLLs: 13
PCSs: o
PIO Cells: 567
PIO Pins: 567
Template Manager
< Back Mext = Cancel

Figure 2.139. Template Manager Entry

4, Systemn Builder

Templates Manager:

Import Delete

Mame

1 Lattice_MachXO5D_RoT_Project 1

Export

Vendor Version = Family

Latticesermi 1.0

LFMX05  RISC-V MC

Processor

Board

MachX05-MNX Development Board REV A

Figure 2.140. Templates Manager Page
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2.4.5.2. Import a Template
1.

“. Import Template Package

Click Import (Figure 2.140), and then choose the desired .ptmp file (Figure 2.141).

&« v » ThisPC » Desktop » test

Organize * New folder

~

. MName
@ OneDrive

2 This PC [ ] sss.ptmp
- 3D Objects
[ Desktop
\ﬂz Documents
‘ Downloads
J! Music
=/ Pictures
n Videos
s Windows (C:)
s Mew Volume (D:

[? Metwork
v

File name: | S55.ptmp

Date modified

10/12/2022 8:17 AM

Type

PTMP File

v

<] £ Search test

==~ T @

Size

4457 KB

v| Ptmp file (*.ptmp)

Lo

Figure 2.141. Import a .ptmp File

2. Custom template installation path.

Custom templates are installed in SHOME/PropelTemplatelLocal directory by default (Figure 2.142).
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4, Options >
Themes; Light -
General Caolar Metwork Settings Directories
IP Tool
IP Install Path: Mave IPs to new location

C:/Users user PropellPLocal
IP Public Path

¥ = \ew_ginip_install
IP Rt Library Path

Templates
Templates Install Path: Maove templates to new location

C:/UsersfuserPropeTemplateLocal
Radiant Location

C:/lscofradiant/2023. 1
Diamond Location
C:/lscc/diamond/3. 12
Questasim Location

D finstall/questasima4_10.6b

Set Default

QK Cancel Apply

Figure 2.142. Template Manager Page

You can move it to another location by checking the Move templates to new location option in Directories tab of the
Options dialog (Figure 2.143).

For custom templates usage in Propel SDK, refer to Lattice Propel 2024.1 SDK User Guide (FPGA-UG-02211).
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4. Options >
Themes: Light -
General Color Metwark Settings Directaories
IP Tool
IP Install Path: Move IPs to new location

C:Usersfuser PropelIPMew
IP Public Path

¥ = \sw_xginYip_install
IF R Library Path

Templates
Templates Install Path: Move templates to new location

C: Usersfuser [PropeTemplateMew
Radiant Location

C: lsccfradiant/2023. 1

Diamond Lecation

C: fleccfdiamond,3. 12
Questasim Location

0. finstall fquestasima4_10.6h

Set Default

oK Cancel Apply

Figure 2.143. Template Manager Page — Change to New Location

2.4.5.3. Delete a Template

Click on the custom template you want to delete from the Template Manager Page (Figure 2.144), and then click
Delete. The corresponding template folder under Template Install Path will be deleted.
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4 System Builder *
Templates Manager:
Mame Vendor Version Family  Processor Board
1 Lattice MachX03D_ReT Project 1 Latticesemi 1.0 LFMXO5  RISC-V MC  MachX03-NX Development Board REV A
Import Delete Export

Figure 2.144. Templates Manager Page — Delete a Template

2.4.6. Include Sub Sbx File

Right Click on Schematic View and choose Add Sbhx Instance (Figure 2.145), and then chose the sbx file you want to
input (Figure 2.146).

Create Port
Add Sbx Instance

[
Auto Connect e

Create Comment
53 Validate Design

Select All
Relayout

Figure 2.145. Right Click on Schematic View
%, Add Sbx Instance *

Instance Name:
Shx File Path:

oK Cancel

Figure 2.146. Input sbx File and Instance Name

Notes:
e The device in the sub sbx must be the same as the device in the top sbx.

e The sub sbx component name cannot be the same as that of the component in the top sbx file.
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e Make sure the top-level ports of the sub sbx are the in/outs of the component in the top-level design. You need to
make the ports you intend on connecting in the top sbx at the top-level in the sub sbx by exporting these ports in
sub sbx.

e Only one-level of hierarchy is supported. A sub sbx file cannot have hierarchical components.

e Support verification project design flow for sub-system sbx. Only one level of sbx component instantiation is
supported.

Auto memory assignment considers memory map for a subordinate or address space of a manager in the sub system
sbx, if there is interconnect bus to connect them. As shown in Figure 2.147, subm_inst and subs_inst are the sub sbx
instances.

subm_inst
e e == 1Y
E cpul_inst sysmemd_inst H
1 ]
1 T HIRDED mHEL MO_INSTR & 2430 1
JI = #IRD 51 TIMER_IRD MO = 1 & AHEL 51 :
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cp_Iret_ret n)_pord I ahblD_inst 1
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: bl_fresetn | AHEL MOL T
| ={arii_hdk_i AHEL MO smemd_inst 1
1 | " ]
! + sEL 50 ]
| ene :
: =tk ]
1 ]
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7] AHEL ML # + sEL
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: =t INT_MD o
1 ot o
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1 =f=
! i
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Figure 2.147. Sub major sbx and sub subordinate sbx

The memory information in sub system sbx is displayed in top-level address tab (Figure 2.148).
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Cell Base Address Range End Address Lock
= sub_inst/cpul_inst
* LocalMemory
cpul_inst/pic_timer_registers 0xFFFFO000 2K OxFFFFOTFF
* design/cpul_inst/riscv_ahbl_m_instr_Address_Space(32 address bits: 4G)
sysmem{_inst/AHBL_50 000000000 32K 0x00007FFF
* design/cpul_inst/riscv_ahbl_m_data_Address_Space(32 address bits: 43)
gpiol_inst/APB_S0 000008400 1K Ox00008TFF
smem{_inst/AHBL_S0 000008000 1K 0x000083FF
smem1_inst/AHBL_S0 0x00008C00 1K Ox00008FFF
sysmem{_inst/AHBL_51 000000000 32K 0x00007FFF
uart(_inst/APB_S0 000008800 1K 0x00008BFF

Figure 2.148. Memory Map for Sub Sbx
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3. TCL Commands

Propel Builder provides TCL commands to execute actions. You can manually enter TCL commands in TCL Console
(Figure 3.1), if you prefer using command lines rather than using the GUI.

Tdl Console

% sbp design close
INFC - Finished: sbp design close
Finished: "sbp_design close™

% sbp design open -name hellc v -path {G:/Lattice/project/Raptor/tool/hw/hello_v/hello_v/hello_v.sbx}
% sbp_design close

INFO - Finished: sbp design close
Finished: "sbp_design close™

Figure 3.1. TCL Console

3.1. sbp_design Commands

The sbp_design command is used as one of the high-level management commands such as opening, closing, of the
design files created by the Propel Builder.

3.1.1. Open

Opens an existing Propel Builder design for modification.
Usage sbp_design open -name <design name> -path <design path> [-device <device name>]

Example sbp_design open -name projectl -path projectl.sbx

3.1.2. Close

Closes a Propel Builder design currently opened.

‘Usage ‘sbp_design close

3.1.3. New

Creates a new Propel Builder design.

Usage sbp_design new -name <new design name> -path <new design path> -device <device name> -

language <language type > —board <board name>

3.1.4. Save

Saves the current Propel Builder design to file on disk or save it as a new file. You can choose to save the design to the
project location (Example 1) or to a specific path (Example 2).

Usage sbp_design save [-path <new design path>]
Example 1 sbp_design save

Example 2 sbp_design save -path new_design.sbx

3.1.5. Drc

Runs the design rule check (DRC) for the Propel Builder design file.
Usage ‘sbp_design drc
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3.1.6. Generate

Generates RTL code to instantiate and connect the IP cores specified in the Propel Builder design file.

Usage

|sbp_design generate

3.1.7. Auto Assign Addresses

Automatically assigns memory mapped addresses to all the subordinates in the system. These addresses should be
chosen to avoid subordinates with multiple non-contiguous address ranges.

Usage

‘sbp_design auto_assign_addresses

3.1.8. Verify
Launches the SOC

verification engine to verify design.

Usage

sbp_design verify [-h] [--workfolder <workfolder_path>] [--sbx_file <sbx_file_path>]
{sim_gen,pfr_pack,regmap_gen,auto_run}

positional arguments: {sim_gen,pfr_pack,regmap_gen,auto_run} specify the application
sim_gen Simulation Generation Flow
pfr_pack PFR Security Engine Packager Flow
regmap_gen Memory Map Generation Flow
auto_run Automation Flow

optional arguments:
-h, --help show this help message and exit
--workfolder WORKFOLDER, -wf WORKFOLDER
assign the working folder. Otherwise, the default one (current working folder) will be
used
--sbx_file SBX_FILE, -sf SBX_FILE
specify the sbx file

Example

sbp_design verify —workfolder ./mem_map —sbx_file D:/ /XO3D_lInitial/XO3D_Initial.sbx regmap_gen

3.1.9. PGE

Runs command with different parameters to call SGE function, DGE function, and Signature inside of PGE (Package

Generate Engine).

e  Runs command to call SGE to generate files for SDK.

Usage

sbp_design pge sge —I <input path> [-o0 <output path>]

-i [Required] the top-level SoC project sbx file full path.

-0 [Optional] output full path, if the parameter is not specified, output path is the same as SoC
project path. sge folder is generated at output path, at present sge folder under the SoC project root

directory.
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e  Runs command to call DGE to generate TCL script that can be used to generate a Diamond or Radiant project.
Usage sbp_design pge dge —i <input path> [-o <output path>] [-diamond [-radiant]

-i [Required] the top level SoC project sbx file full path.

-0 [Optional] output full path, if the parameter is not specified, output path is the same as SoC
project path. For DGE, TCL script and related files are generated at output path. At present, Diamond
or Radiant project share the same workspace with SoC project.

-diamond [Optional] flag to execute DGE for diamond project.

-radiant [Optional] flag to execute DGE for Radiant project.

e  Run command to generate signature.

e  PGE gets partial UFM3 contents including version packetl), Sentry PFR configure data (D), and call Flash Address
Tool to sign with private key from Factory HSM.

Usage ‘sbp_design pge gen_signature -cfile <c binary file> -dfile <d binary file> -output <output binary file>
3.1.10. Undo

Undo operation. Currently, software only supports single undo.

Usage |sbp_design undo

3.1.11.Redo

Redo operation. Currently, software only supports single redo.

Usage ‘sbp_design redo

3.1.12. Set Device

Modify the device information including device, package, speed, operating condition.
Usage sbp_design set_device -device <device name> -speed <speed value> -package <package value> -
operating <operating condition>

3.2. Other TCL Commands

The following commands are used for specifying connectivity and IP instantiation to the Propel Builder backend.

3.2.1. sbp_create_project

Create a new propel builder project.

Usage sbp_create_project -name <new_project_name> -path <project_path> -language <Verilog/VhdI> -
psc <constrain_file_name> -device <device_name> -speed <device_speed> -board
<board_name(version)>

3.2.2. sbp_add_component

Instantiates an IP component into the system. Must specify the component VLNV identifier. This corresponds to a
component instance in the IP-XACT design. For example, the command below can instantiate an AHB-Lite interconnect
component.

Usage sbp_add_component -vinv <VLNV> -name <instance_name>

Example sbp_add_component -vinv lattice:ip:ahbl_interconnect:1.0 -name ahblite_interconnect
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3.2.3. sbp_add_sbxcomp

Instantiates a hierarchical component from sbx file into the system.

Usage sbp_add_sbxcomp -name <hname> -path <sbx_file_absolute_path_name>

Example sbp_add_sbxcomp -name sim_comp -path “C:/test/test.sbx”

3.2.4. sbp_config_ip
args:

e -vInv: component vinv, consisted with vendor, library, name, version. When use this TCL command, vendor, library,
version of component must be the same as meta_vinv.

e -meta_vinv: Location of IP configuration file by vendor library name and version, use TCL "ip_catalog_list" to get it.
Usage: 'vendor:library:name:version'.

o -cfg_value: IP configuration value: '{id:value, id1:valuel}'.
e -meta_loc: Location of IP module package.

e -cfg: Location of IP configuration file.
Note: This TCL command must contains one of -meta_vInv and -meta_loc, also -cfg_value and -cfg.

Usagel sbp_config_ip -vinv <component vinv> -meta_vinv {IP vinv} [-cfg_value <IP configuration value>]
Examplel sbp_config_ip -vinv {latticesemi.com:ip:gpio0:1.6.1} -meta_vInv {latticesemi.com:ip:gpio:1.6.1} -
cfg_value {DIRECTION_DEF_VAL_INPUT:FF,IO_LINES_COUNT:8,OUT_RESET_VAL_INPUT:FF}
Usage2 sbp_config_ip -vinv <component vinv> -meta_loc {location} -cfg <IP configuration file>
Example2 sbp_config_ip -vinv {latticesemi.com:module:osc1:2.0.A} -meta_loc {{home/user/work/osc} -cfg
{/home/user/work/tt1/tt1/.lib/latticesemi.com/module/osc1/2.0.A/oscl.cfg}

3.2.5. ip_catalog_list
Return a list of IP, local IP contains the IP from Propel install package, IP server and customer's packaged IP, server IP
contains the IP in server. Only get local IP by default.

args:

-server: Get IP list in server.

Usage ip_catalog_list [-name <IP wild name>] [-library <IP wild library>] [-vendor <IP wild vendor>]
[-version <IP wild version>] [-server]

Example ip_catalog_list -name adder*

3.2.6. ip_catalog_install
Install one IP from local ipk file or one IP from server.
args:

e -vinv: Location of IP configuration file by vendor library name and version, use tcl 'ip_catalog_list' to get it. Usage:
'vendor:library:name:version'.

o -file: ipk file on user local path.

Usage ip_catalog_install [-vInv <IP vinv>] [-file <ipk file name>]

Example ip_catalog_install -vinv latticesemi.com:ip:watchdog_timer:1.1.0 -file <local
path>/watchdog_timer.ipk

3.2.7. ip_catalog_uninstall
Uninstall one IP from local IPs, ip_catalog_list can list all installed local IPs.
args:
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e -vInv: Location of IP configuration file by vendor library name and version, use tcl 'ip_catalog_list' to get it. Usage:
'vendor:library:name:version'.
Usage ip_catalog_uninstall [-vinv <IP vinv>]

Example ip_catalog_uninstall -vinv latticesemi.com:ip:watchdog_timer:1.1.0

3.2.8. sbp_upgrade_component
Reconfig component with latest IP version.

Usage sbp_upgrade_component -all/-component <component name> [-force_update] [-version <version
number>]
Example sbp_upgrade_component -component gpio0_inst -version 2.5.0

3.2.9. sbp_add_gluelogic

Instantiates a gluelogic component into the system.
Usage sbp_add_gluelogic —name <instance_name> -logicinfo <logic json info from sbp_create_glue_logic>

Example sbp_add_gluelogic -name equation_module_inst -logicinfo [sbp_create_glue_logic equation
equation_module {}“{{"”"x"r":"IA” ”B","module_"a"e":"equation_mo”ule"}}]
Note: This is an internal command. Modify existing usage is not recommended.

3.2.10. sbp_create_glue_logic

Create gluelogic information when adding gluelogic component. rtl_path must be a file path if gluelogic comes from a
file. Else be empty.
Usage sbp_create_glue_logic <type> <module_name> <rtl_path> <json cfg data>

Example sbp_add_gluelogic -name equation_module_inst -logicinfo [sbp_create_glue_logic equation
equation_module {}“{{""x"r":"IA” ”B","module_"a”e":"equation_mo”ule"}}]
Note: This is an internal command. Modify existing usage is not recommended.

3.2.11. sbp_ reconfig _gluelogic

Allow user to reconfig gluelogic component.

Usage sbp_ reconfig _gluelogic —-name <instance_name> -logicinfo <logic json info from
sbp_create_glue_logic>

Example sbp_reconfig_gluelogic -name equation_moduleQ_inst -logicinfo [sbp_create_glue_logic equation
equation_module0 {} { {"expr":"A & B","module_name":"equation_module0"}}]

Note: This is an internal command. Modify existing usage is not recommended.

3.2.12.sbp_add_port

Creates a top-level I/0 port. Must specify the direction.
‘Usage ‘sbp_add_port [-from <bit number>] [-to <bit number>] -direction <in/out/inout> <port_name>

3.2.13. sbp_modify_port

Modify existing top-level ports to change the width and the direction.
‘Usage sbp_modify_port -name <port_name> [-from <bit number>] [-to <bit number>] -direction <dir.>

3.2.14.sbp_connect_net

Connects all of the specified pins and/or ports to the same net. The arguments can be pins or ports in the system
design. Only one of the arguments can be the driver (output pin/port), driving all other input pin/ports. Example below
connects the clk port to all components, assuming component pins are all named clk.
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Usage sbp_connect_net [-name <net name>] <pin/port> <pin/port>

Example sbp_connect_net [sbp_get_pins clk] {CLOCK_IN}

3.2.15. sbp_connect_interface_net

Connects a bus interface pin/port to another interface pin/port. This corresponds to the interconnection element in the
IP-XACT design.
‘Usage Isbp_connect_interface_net <pin/port> <pin/port>

3.2.16. sbp_connect_constant

Connects a constant integer to a pin/pinbus/port/portbus. To assign to a pin/pinbus, the object must be an input
pin/pinbus. To assign to a port/portbus, the object must be an output port/portbus. If the integer requires multiple
bits, not 0 or 1, then the object must be a bus. The TCL command can be used to assign the same constant to multiple
pin/pinbus/port/portbus at the same time.

Usage sbp_connect_constant -constant <integer> <pin/pin bus/ port/portbus> <pin/pin bus/
port/portbus>...
Example sbp_connect_constant -constant 1 {test/i2c_mst_apb/rst_n_i} {test/riscv/clk_i}

3.2.17. sbp_connect_whitebox

User can do connection cross the hierarchy boundary for verification purpose.
Usage sbp_connect_whitebox <design_name/vip_inst_name/pin_name>
<design_name/uit_inst_name/port_name>

3.2.18. sbp_connect_ group

Allow user to connect a group of signals.

Usage sbp_connect_group -ports {<source portl> <destination portl> <destination port2>; <source port2>
<destination port3> <destination port4>} -nets {<net_name1> <destination portm1> <destination
portm2>; <net_name2> <destination portm3>} -interfaces {<interfacel> <interface2>; <interface3>
<interface4>}

3.2.19. sbp_disconnect_whitebox

Removes the connection cross the hierarchy boundary.

Usage sbp_disconnect_whitebox <design_name/vip_inst_name/pin_name>
<design_name/uit_inst_name/port_name>

3.2.20. sbp_disconnect_interface_net

Disconnects an interface pin/port from the interface nets they attached to. Note that any interface pin or interface port
can attach to one interface net at the most.

‘Usage ‘sbp_disconnect_interface_net <pin/port> <pin/port>

3.2.21.sbp_disconnect_net

Disconnects all of the specified input pins and/or ports from the nets they attached to. Note that any pin or port can
attach to one net at the most. Can also be used to disconnect a constant that is connected to a pin/port with
connect_constant.
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‘Usage ‘sbp_disconnect_net <pin0> <pinl> <port2> ‘

3.2.22. sbp_assign_addr_seg

Assigns a memory map between a pair of manager and subordinate interfaces. Range specifies the range of the
segment, for example, 32‘h0000400, 32°‘h0001000. Offset specifies the base offset of the range, for example,
32'h0000400

Usage sbp_assign_addr_seg -offset <offset> < subordinate connection name>
Example sbp_assign_addr_seg -offset 32‘h00001000 simple/riscv/AHBL_S00

3.2.23. sbp_unassign_addr_seg

The TCL command unsets the fixed offset flag for a memory map allowing the auto_assign TCL command to assign the
memory map offset.
Usage sbp_unassign_addr_seg < subordinate interface name>

Example sbp_unassign_addr_seg simple/spi/AHB_S00

3.2.24. sbp_assign_local_memory

Assigns a base address to a local memory map of a manager address space.
Usage sbp_assign_local_memory -offset <offset> <master_addr_space>

Example sbp_assign_local_memory -offset ‘h0050000 Foundation_SoC/riscv/ahbl_m_data_Address_Space

3.2.25. sbp_export_pins

Exports a list of pins or interface pins, or all not-yet-connected pins of the components to the top-level port list in the
design. The function detects whether or not the argument is pin(s) or component(s). In the two examples below,
Example 1 demonstrates a TCL command to export the pin init_done, while Example 2 demonstrates a TCL command
to export all pins and interfaces of the ddr3 component.

Usage sbp_export_pins <pin/component> <pin/component>
Example 1 sbp_export_pins {ddr3/init_done}
Example 2 sbp_export_pins {ddr3}

3.2.26.sbp_export_interface

Exports bus interfaces that are passed as arguments to the TCL command from the component to the top-level
component. Example below exports the AHBL_MASTER bus interface of the RISC-V component to the top-level
component.

Usage sbp_export_interfaces <interface> <interface> <interface>

Example sbp_export_interfaces simple/riscv/AHBL_MASTER

3.2.27.sbp_rename

The rename TCL command renames objects within the design. The new name of the object and the current hierarchical
name of the given object are used as the parameter value. The object can be an interface connection, connection, port,
interface, or component. The example below demonstrates the changing of the name of a port in milestone project
from CLK to CLOCK.

Usage sbp_rename -name <new name> <object name>

Example sbp_rename -name CLOCK milestone/CLK

www.latticesemi.com/legal


http://www.latticesemi.com/legal

== LATTICE

3.2.28. sbp_replace

The Replace (Re-Config) TCL command replaces a component with a new configuration for itself. VLNV refers to the
newly-generated IP, component name refers to the existing component that is to be replaced, and instance refers to
the instance name of the component with new configuration.

Usage

sbp_replace -vinv <VLNV> -name <instance> -component <component name>

Example

sbp_replace -vinv lattice:ip:ahblite_bus_0:1.1 -name ahbl_bus_0 -component simple/ahblite

3.2.29. sbp_copy

Copies objects, IP instances and nets, from the current or other open sbp designs to the current sbp design. All objects
are post-fixed with a postfix string. For example, you can write TCL code below to duplicate the components and
connections with new instance names post fixed with X, by calling copy on all the components, ports and nets. Pins are
automatically duplicated while the components are duplicated.

Usage

sbp_copy -postfix <postfixString> objects

Example

sbp_copy —postfix X Sselected_objs

3.2.30.sbp_delete

Deletes objects, IP instances and nets, from the current sbp design. In the examples below, Example 1 demonstrates a
TCL command to delete a port, while Example 2 demonstrates a TCL command to delete ddr3 component.

Usage Sbp_delete objects -type <type name>
Example 1 sbp_delete [sbp_get_ports <clock>] -type port
Example 2 sbp_delete {ddr3} -type component

3.2.31.sbp_get_pins

Gets a list of pin names that match a pattern string, and/or the pins that are associated with an object. The object in
the [-from <objectName>] option can be a net or a component. The example below gets the clk pin from the

interconnect IP.

Usage

sbp_get_pins [-from <object Name>] [pattern]

Example

sbp_get_pins -from ahblite_interconnect clk

3.2.32.sbp_get_interface_pins

Gets a list of interface names that match a pattern string, and/or the interfaces that are associated with an object. The
object in the [-from <objectName>] option can be an interface net or a component. The example below can get all
AHB-Lite subordinate interface pins from the interconnect IP.

Usage:

sbp_get_interface_pins [-from <objectName>] [pattern]

Example:

sbp_get_interface_pins -from ahblite_interconnect S*_AHB

3.2.33.sbp_get_ports

Get a list of the names of ports that match a pattern string, and/or the ports that are associated with an object. The
object in the [-from <objectName>] option can be a net.

‘Usage

‘sbp_get_ports [-from <objectName>] [pattern]
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3.2.34.sbp_get_interface_ports

Gets a list of interface names that match a pattern string, and/or the interface ports that are associated with an object.
The object in the [-from <objectName>] option can be an interface net.
‘Usage Isbp_get_interface_ports [-from <objectName>] [pattern]

3.2.35.sbp_get_nets

Gets a list of net names that match a pattern string, and/or the nets that are associated with an object. The object in
the [-from <objectName>] option can be a pin or a port.
‘Usage |sbp_get_nets [-from <objectName>] [pattern]

3.2.36.sbp_get_interface_nets

Gets a list of interface net names that match a pattern string, and/or the interface nets that are associated with an
object. The object in the [-from <objectName>] option can be an interface pin or an interface port.
‘Usage ‘sbp_get_interface_nets [-from <objectName>] [pattern]

3.2.37.sbp_set_property

Sets the properties of an input object. The first argument is a list of name value pairs. We have a list of parameters
because the GUI IP configuration dialog submits changes to many parameters of an IP component at the same time
when the dialog is closed. In the examples below, Example 1 changes the data width of the RAM block named “ebr_0",
while Example 2 changes the number of manager interfaces to two and number of subordinate interface to three on
AHB-Lite interconnect block named “ahbl_interconnect”.

Usage sbp_set_property <name0 value0 namel valuel ...> object
Example 1 sbp_set_property {datawidth 32} {test/ebr_0}
Example 2 sbp_set_property {(NUM_MI 2 NUM_SI 3} test/ahbl_interconnect

3.2.38. sbp_get_property

Gets the property of the object. The example below is to get the number of subordinate interfaces of AHB-Lite
interconnect block named “ahbl_interconnect_0".
Usage sbp_get_property <parameter name> <object>

Example sbp_get_property NUM_SI ahbl_interconnect_0

3.2.39. sbp_report_properties

Prints all the properties and values associated to the type of the object.
Usage sbp_report_properties object

Example sbp_report_properties ahbl_interconnect

Outputs Name: ahbl_interconnect
NUM_SI: 1

NUM_MI: 2
DATA_WIDTH: 32
IADDRESS_WIDTH: 32
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3.2.40.sbp_get_components

Gets a list of component names that match a pattern string, and/or the components that are associated with an object.
The default pattern string is a wildcard “*” that matches all components. The pattern string may consist of string
segments and wildcards. The example below returns all the component names that contain “interconnect”. The
command returns an empty string if no match is found.

Usage sbp_get_components <component name>

Example sbp_get_components {*interconnect*}

3.2.41. sbp_design set_prj_option
Change the output language (Verilog or VHDL) after the project was created.

Usage sbp_design set_prj_option -language <Verilog or VHDL>

Example sbp_design set_prj_option -language Verilog

3.2.42. sbp_design gen_tcl

Generate TCL file for design project in project folder.

Usage sbp_design gen_tcl

Example sbp_design gen_tcl
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Technical Support Assistance

Submit a technical support case through www.latticesemi.com/techsupport.

For frequently asked questions, refer to the Lattice Answer Database at
https://www.latticesemi.com/Support/AnswerDatabase
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